
 

 

 

О. В. Піонткевич, С. І. Сухоруков, 

О. В. Петров, О. В. Сердюк 

 

 

 

«Комп’ютеризовані системи проєктування» 

для здобувачів вищої освіти зі спеціальності 

«Прикладна механіка» 

 

 

 



 

1 

Міністерство освіти і науки України 

Вінницький національний технічний університет 

 

 

О. В. Піонткевич, С. І. Сухоруков, 

О. В. Петров, О. В. Сердюк 

 

 

 

 

 

 

 

«Комп’ютеризовані системи проєктування» 

для здобувачів вищої освіти зі спеціальності 

«Прикладна механіка» 

 

Електронний лабораторний практикум 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Вінниця 

ВНТУ 

2025 

  

 



 

2 

УДК 004.925.84:004.94:621.8(076) 

К63 

 

Рекомендовано до видання Вченою радою Вінницького 

національного технічного університету Міністерства освіти і науки 

України (протокол № 8 від 30.01.2025 р.) 

 

Автори: 

О. В. Піонткевич, С. І. Сухоруков, О. В. Петров, О. В. Сердюк 

 

 

 

Рецензенти: 

О. Узунов, доктор технічних наук, професор 

Я. Іванчук, доктор технічних наук, професор 

Б. Корчевський, кандидат технічних наук, доцент 

 

 

 
 

«Комп’ютеризовані системи проєктування» для здобувачів 

вищої освіти зі спеціальності «Прикладна механіка» : лабораторний 

практикум [Електронний ресурс] / О. В. Піонткевич, С. І. Сухоруков, 

О. В. Петров, О. В. Сердюк. Вінниця : ВНТУ, 2025. 142 с. 
 

У виданні стисло викладено основні положення курсу «Комп’ютеризовані 

системи проєктування», за якими виконуються лабораторні роботи. Наведено 

приклади використання CAD системи SOLIDWORKS для побудови ескізів, 

тривимірних моделей та креслеників деталей. Розроблено завдання та наведено 

необхідні довідкові матеріали для виконання лабораторних робіт. Для 

самоконтролю готовності до лабораторних робіт у практикумі наприкінці 

кожної теми наведено контрольні питання. Видання розроблено відповідно до 

плану кафедри технологій та автоматизації машинобудування та програми 

навчальної дисципліни «Комп’ютеризовані системи проєктування» для 

виконання лабораторних робіт здобувачами бакалаврського рівня вищої освіти 

спеціальності «Прикладна механіка». Лабораторний практикум може бути 

використаний в процесі підготовки студентів інших спеціальностей. 

УДК 004.925.84:004.94:621.8(076) 

 

 

 

 

 

 

 

© ВНТУ, 2025  

 

К63 



 

3 

ЗМІСТ 

 

 

ВСТУП....................................................................................................... 

 

4 

ЛАБОРАТОРНА РОБОТА № 1. ЗАГАЛЬНІ ПРИНЦИПИ 

ТРИВИМІРНОГО ПРОЄКТУВАННЯ ВИРОБІВ В SOLIDWORKS .. 

 

 

6 

ЛАБОРАТОРНА РОБОТА № 2. ПОБУДОВА ЕСКІЗІВ ІЗ 

ВИКОРИСТАННЯМ ВЗАЄМОЗВ’ЯЗКІВ ……………………………. 

 

 

17 

ЛАБОРАТОРНА РОБОТА № 3. СТВОРЕННЯ ТВЕРДОТІЛЬНИХ 

ТРИВИМІРНИХ МОДЕЛЕЙ ДЕТАЛЕЙ …………………………….. 

 

36 

 

ЛАБОРАТОРНА РОБОТА № 4. ВИКОРИСТАННЯ БІБЛІОТЕК В 

ТРИВИМІРНОМУ МОДЕЛЮВАННІ ……………………………….. 

 

 

 

62 

ЛАБОРАТОРНА РОБОТА № 5. СТВОРЕННЯ АСОЦІАТИВНИХ 

КРЕСЛЕНИКІВ ІЗ ТРИВИМІРНИХ МОДЕЛЕЙ ДЕТАЛЕЙ ……….. 

 

88 
  

ЛАБОРАТОРНА РОБОТА № 6. ЛИСТОВЕ ТРИВИМІРНЕ 

МОДЕЛЮВАННЯ ДЕТАЛЕЙ ТА ЇХ КРЕСЛЕНИКИ ………………. 

 

115 

  
ОФОРМЛЕННЯ ЗВІТУ З ЛАБОРАТОРНИХ РОБІТ ………………... 138 

  

ЛІТЕРАТУРА …………………………………………………………… 140 

  



 

4 

ВСТУП 

 

 

Навчальна дисципліна «Комп’ютеризовані системи проєктування» 

вивчається здобувачами бакалаврського рівня підготовки зі спеціальності 

«Прикладна механіка». 

Мета розробки лабораторного практикуму – отримання 

практичних навичок та закріплення теоретичного матеріалу у роботі, 

пов’язаній з проєктуванням деталей та механізмів на персональному 

комп’ютері; з підготовкою конструкторської документації на основі 

комп’ютеризованої системи проєктування; з ознайомленням та 

розширенням практичних вмінь володіння програмними модулями 

SOLIDWORKS. 

Порядок виконання лабораторних робіт. Лабораторні роботи 

проводяться в сучасних аудиторіях 1209 чи 1211 із використанням 

персональних комп’ютерів. Основним інструментом для виконання 

лабораторних робіт є програмне забезпечення, на базі програмного 

продукту SOLIDWORKS. 

В процесі знайомства зі здобувачами викладач має розповісти про 

план лабораторних робіт на поточний семестр, який закладено в даному 

курсі дисципліни «Комп’ютеризовані системи проєктування». Здобувачам 

пояснюється специфіка проведення лабораторних робіт в аудиторії, яка 

визначена правилами внутрішнього розпорядку, а також вимогами 

охорони праці та пожежної безпеки. 

Кожний здобувач самостійно ознайомлюється та вивчає відповідні 

документи, строго дотримуватися цих правил і вимог та підтверджує це 

власним розписом у журналі цієї аудиторії. Крім цього, здобувачів 

попереджають, що вони несуть матеріальну відповідальність за збитки, які 

виникли через необережне чи недбале ставлення до лабораторних засобів 

та обладнання.  

Процес виконання лабораторних робіт охоплює: ознайомлення та 

вивчення теоретичного матеріалу; підготовку заготовки звіту з 

індивідуальним завданням; виконання запланованих робіт на 

персональному комп’ютері; оформлення звіту з фіксацією результатів у 

вигляді знятків (screenshots) та висновків, захист лабораторних робіт. 

Приклад оформлення звіту знаходиться в кінці лабораторного 

практикуму. Усі лабораторні роботи об’єднані одним титульним аркушем, 

на якому вказується інформація про заклад освіти, кафедру, назву 

дисципліни, варіант, номер академічної групи, ім’я та прізвище здобувача, 

яким виконано роботу, та викладача, який приймає звіт, рік та місто здачі 

звіту. Кожна лабораторна робота починається з нового аркушу з такою 

шапкою: лабораторна робота з вказанням номера, тема та мета 

лабораторної роботи, хід виконання роботи, в якому фіксуються 

результати виконання лабораторної роботи. Кожна лабораторна робота 
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закінчується висновком, де описуються набуті чи закріплені навички, 

отримані результати, а також можливі шляхи подальшого розвитку. 

Система модульно-рейтингового оцінювання лабораторних 

робіт. Результати виконання та захисту лабораторних робіт оцінюються 

балами, загальна кількість яких становить відповідну частину абсолютної 

бальної оцінки дисципліни, яка зазначена в робочій програмі навчальної 

дисципліни. 

Кожна лабораторна робота оцінюється згідно з чинною бальною 

системою за такими показниками:  

- якість підготовки здобувача до виконання лабораторної роботи 

(оцінюється під час опитування на початку заняття);  

- рівень самостійності та ступінь розуміння матеріалу заняття 

(оцінюється в процесі виконання роботи та під час захисту лабораторної 

роботи);  

- якість оформлення результатів виконання роботи (оцінюється за 

надісланим звітом).  

Загальна оцінка визначається як середнє оцінок з наведених вище 

показників та перераховується у абсолютні бали модульно-рейтингової 

системи.  

Техніка безпеки. Під час виконання лабораторних робіт потрібно 

дотримуватися загальних правил техніки безпеки і вимог до поведінки 

здобувачів у лабораторії. Лабораторна робота виконується тільки з дозволу 

викладача, а також в присутності викладача або навчального майстра, 

інженера.  

Здобувачам забороняється: самостійно усувати несправності, що 

виникають; класти сторонні предмети на робочі місця; вмикати 

персональні комп’ютери без дозволу і присутності викладача; залишати 

без нагляду ввімкнений персональний комп’ютер. 

Допуском до лабораторної роботи є власноручний підпис здобувача 

напроти свого прізвища в спеціальному журналі з техніки безпеки для цієї 

лабораторії та перевірені знання здобувача з правил техніки безпеки і 

правил поведінки у процесі виконання лабораторних робіт.  

Примітка. В кожній навчальній аудиторії та лабораторії на стенді 

розміщено вказані правила та вимоги, підписані посадовими особами 

кафедри та університету. 
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ЛАБОРАТОРНА РОБОТА № 1 

 

ЗАГАЛЬНІ ПРИНЦИПИ ТРИВИМІРНОГО ПРОЄКТУВАННЯ 

ВИРОБІВ В SOLIDWORKS 

 

 

Мета роботи. Ознайомлення з загальними принципами побудови 

тривимірних моделей деталей в системі автоматизованого проєктування 

SOLIDWORKS. 

 

1.1 Короткі теоретичні відомості 

 

Програма SOLIDWORKS – це система автоматизованого 

проєктування (Computer-aided design), інженерного аналізу (Computer-

aided engineering) та підготовки виробництва (Computer-aided 

manufacturing) механічних вузлів і виробів. В основу програми покладено 

зручний інструмент об’ємного параметричного моделювання [1], який 

використовує графічний інтерфейс користувача системи Windows. 

Вищезгаданий курс дисципліни «Комп’ютеризовані системи 

проєктування» передбачає ознайомлення з частиною автоматизованого 

проєктування функціонала програми SOLIDWORKS. 

Перед початком роботи в SOLIDWORKS потрібно вказати 

параметри користувача System Options  (рисунок 1.1) [2, 3] та 

налаштувати шаблони за власними потребами.  

Всі налаштування користувача System Options є персональними та 

стосуються всіх модулів програми, а не для окремого шаблона. 

На рисунку 1.1 показано основні параметри для налаштування. Після 

налаштування вкладки General, потрібно ознайомитися з вкладкою MDB, 

яка відповідає за можливість використання безкреслярського 

проєктування. Вкладка Drawings відповідає за відображення елементів на 

креслениках, стиль відображення моделі, тип штриховки та інше. 

Проведенні налаштування можна швидко змінити в процесі проєктування, 

наприклад, додати або прибрати тіні від тривимірної моделі за рахунок 

основного меню програми: View ⇒ Display ⇒ Shadows In Shaded Mode. 

Вкладка Colors в програмі SOLIDWORKS відповідає за 

налаштування кольорів елементів інтерфейсу. Наприклад, зміна фону 

робочої області за допомогою налаштувань кольорів. Щоб це зробити, слід 

використати такий шлях: Tools ⇒ Options ⇒ System Options ⇒ Colors. 

За налаштування відображення ключових елементів моделювання 

відповідають вкладки Sketch, Display, Assemblies, FeatureManager та 

інші. Зазвичай їхніх налаштувань за замовчуванням вистачає для 

комфортної роботи в програмі SOLIDWORKS. 

Вкладки Default Templates та File Locations відповідають за опис 

шляху про розміщення шаблонів документів SOLIDWORKS. 
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Рисунок 1.1 – Параметри користувача SOLIDWORKS 

 

Для налаштування функції автоматичного зберігання виконаної 

інформації в SOLIDWORKS рекомендується перейти на вкладку 

Backup/Recover та поставити галочку Save auto-recover information every. 

Повний шлях для налаштування: Tools ⇒ Options ⇒ System Options ⇒ 

Backup/Recover ⇒ Auto Recover. При цьому потрібно вказати 

періодичність і місце для збереження. 

Вкладки Import та Export відповідають за налаштування за 

замовчуванням програми SOLIDWORKS для імпорту та експорту файлів. 

Проєктування в програмі SOLIDWORKS передбачає створення 

тривимірних моделей виробів з можливістю виконувати їх кресленики. 

Створення нового документа в програмі SOLIDWORKS зазвичай 

виконують натисканням на кнопку New або комбінацією клавіш Ctrl+N. 

З’явиться діалогове вікно вибору шаблону документа: Part (Деталь.sldprt), 

Assembly (Складальна одиниця.sldasm) або Drawing (Кресленик.slddrw) 

(рисунок 1.2). У разі вибору шаблону Part або Assembly відкриється 

можливість працювати в тривимірному просторі. 

Робоче вікно програми SOLIDWORKS створеного документа Part 

показано на рисунку 1.3 з усіма потрібними елементами [4].  
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Рисунок 1.2 – Діалогове вікно вибору шаблону нового документа 

 

 
 

Рисунок 1.3 – Загальний вигляд інтерфейсу програми SOLIDWORKS 

 

У процесі виконання лабораторних робіт будемо використовувати 

[4]: Menu Bar (рядок меню), Quick Access Toolbar (панель швидкого 

доступу), Search Bar (рядок пошуку), CommandManager (панель 

інструментів) разом із Tabs (вкладки), View (Heads-Up) Toolbar (панель 

інструментів для перегляду), справа Task Panes (панель завдань) та зліва 

панель керування з відкритою вкладкою FeatureManager Design Tree 

(дерево проєктування основного менеджера) разом з іншими менеджерами 
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там, де знаходиться курсор Graphics Area (область побудови), знизу 

Status Bar (рядок стану) та Unit System (система одиниць). 

Перед роботою в документі Part рекомендується провести 

налаштування його параметрів та зберегти в шаблоні. Відкриття 

налаштування параметрів документа Part виконується за допомогою 

шляху System Options ⇒ Document Properties (рисунок 1.4). Перше 

налаштування вкладки Drafting Standard відповідає за загальні 

використовувані стандарти, в нашому випадку – це GOST. Програмою 

передбачено збереження свої налаштувань і завантаження раніше 

збережених налаштувань із спеціальних файлів та розширенням *.sldstd.  

Вкладка Annotation забезпечує налаштування таких елементів: 

Balloons, Datums, Geometric Tolerances, Notes, Revision Clouds, Surface 

Finishes та Weld Symbols. При цьому визначається, за якими стандартами 

показується позначення, налаштовуються шрифти написів і параметри 

використовуваних ліній і стрілочок. 
 

 
 

Рисунок 1.4 – Налаштування параметрів документа Part 

 

Вкладка Dimensions відповідає за налаштування різного типу 

розмірів, а саме: Angle, Angular Running, Arc Length, Chamfer, Diameter, 

Hole Callout, Linear, Ordinate та Radius. Зокрема налаштовуються 

параметри стрілочок, позиціонування розміру, розміри і тип шрифтів 

написів, відображуваних знаків після коми. 

Налаштування відображуваних таблиць в документах SOLIDWORKS 

виконується у вкладці Tables за шляхом Tools ⇒ Options ⇒ Document 

Properties ⇒ Tables. 
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Налаштування вкладки DimXpert забезпечує вибір стандарту 

відображуваних елементів під час нанесення тривимірних розмірів, 

допусків форми та розташування. DimXpert – це набір інструментів, який 

використовується для нанесення розмірів і допусків для виробів відповідно 

до вимог стандартів ASME Y14.41-2003 та ISO 16792:2006. 

Налаштування сітки під час роботи з ескізами деталі виконується у 

вкладці Grid/Snap. Відображення сітки відбувається у разі активації 

галочки: Tools ⇒ Options ⇒ Document Properties ⇒ Grid/Snap ⇒ Display 

grid, а налаштування відстані між лініями сітки виконуємо за Tools ⇒ 

Options ⇒ Document Properties ⇒ Grid/Snap ⇒ Major grid spacing. За 

допомогою сітки в SOLIDWORKS комфортно проєктувати нескладні 

деталі, прив’язуючись до вузлів сітки. 

Одиниці вимінювання для документів SOLIDWORKS 

налаштовуються у вкладці Units за шляхом: Tools ⇒ Options ⇒ Document 

Properties ⇒ Units. Згідно з міжнародною системою одиниць (SI) ми 

користуємося метричною системою вимірювань. Однак на тривимірних 

моделях та креслениках в машинобудуванні прийнято використовувати 

розміри в міліметрах. Найбільш доцільно обирати параметри Unit system 

⇒ MMGS (millimeter, gram, second). У такому разі маса виробів буде 

відображатися в грамах. Зміна налаштувань одиниць вимірювання 

проводиться за допомогою параметра Unit system ⇒ Custom. Тоді ж 

з’являється доступ до таблиці з одиницями вимірювання (рисунок 1.5), та 

проведено зміну параметра Mass на kilograms. 

Після проведення налаштувань в документі Part натискаємо кнопку 

OK (рисунок 1.5). Це дозволить застосувати налаштування для документа 

Part, з яким працює користувач. 

Для збереження проведених налаштувань в шаблоні документа Part 

потрібно перейти за шляхом: File ⇒ Save As… та обрати тип файлу Part 

Templates (*.prtdot). Тоді програма SOLIDWORKS автоматично відкриє 

для користувача папку templates, де зберігаються усі шаблони. 

Користувачу лише потрібно замінити наявний там файл Part.PRTDOT 

(рисунок 1.6), або створити свій документ. 

Після проведення налаштувань параметрів користувача та шаблонів 

документів потрібно ознайомитися з загальними принципами 

проєктування. Варто розуміти, що процес побудови тривимірних моделей 

базується на операціях додавання та зняття матеріалу, що, насправді, 

повторює реальні методи технологічної обробки заготовок деталей в 

машинобудуванні. 
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Рисунок 1.5 – Налаштування одиниць вимірювання в SOLIDWORKS 

 

 
 

Рисунок 1.6 – Збереження шаблону документа Part 
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Загальний принцип проєктування твердотільних тривимірних 

моделей виробів (цей вид моделей буде безпосередньо освоєний в цьому 

курсі лабораторних робіт) виражається такою послідовністю: 

 вибір площини для побудови ескізу; 

 побудова елементів двовимірного ескізу, нанесення розмірів, 

визначення взаємозв’язків; 

 виконання операцій зі створення тривимірних об’єктів із 

двовимірних ескізів, а саме: надання товщини об’єктам ескізу 

(витягування, поворот та інші). 

В такому разі інструменти з самої панелі інструментів 

SOLIDWORKS дозволяють поетапно виконати поставлені задачі, а 

результат моделювання через FeatureManager Design Tree забезпечує 

відслідковування всіх виконаних операцій, змінювати значення будь-якого 

розміру, визначати взаємозв’язки на взаємне розташування змодельованих 

елементів протягом усього процесу проєктування. 

Працюючи з будь-яким інструментом потрібно орієнтуватися на 

повідомлення, яке з’являється поруч із курсором миші, коли навести його 

на кнопку. На рисунку 1.7 показано повідомлення про подальші дії після 

натиснення кнопки Sketch, а саме: система підказок пропонує вибрати 

площину для створення ескізу [4]. 

Зліва від Graphics Area на панелі керування крім PropertyManager 

є інші вкладки, які динамічно змінюються залежно від виконуваних дій. 

Наприклад, коли закінчили роботу з кнопкою Sketch, панель керування 

перемикається з PropertyManager на FeatureManager Design Tree. Між 

вкладками панелі керування також можна перемикати вручну. 

FeatureManager Design Tree є однією з найважливіших частин 

інтерфейсу програми SOLIDWORKS. Це місце, де забезпечується 

керування елементами моделі, їх редагування, приховування, вилучення 

тощо. У процесі моделювання нові ескізи чи елементами моделі 

з’являються в FeatureManager Design Tree в тому порядку, у якому були 

створені. 

FeatureManager Design Tree містить Features (елементи 

моделювання) з ескізами, Default Planes (стандартні площини), Origin 

(положення виробу), Metadata (метадані про виріб): матеріал, папка 

анотацій, датчики та історія змін (рисунок 1.8). 

Назва Part завжди відображається у верхній частині 

FeatureManager Design Tree з активною конфігурацією (в прикладі на 

рисунку 1.8 показано конфігурація Default). Rollback Bar дозволяє 

переміщувати лінію побудови так, щоб приховати попередню роботу та 

продовжити з місця, де вона розташована. 
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Рисунок 1.7 – Приклад роботи системи підказок у процесі створення ескізу 
 

 
 

Рисунок 1.8 – Основні елементи FeatureManager Design Tree 
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Декілька фактів про FeatureManager Design Tree: 

o якщо клацнути лівою кнопкою миші на елементі в 

FeatureManager Design Tree, поруч із курсором з’явиться контекстна 

панель інструментів із відповідними кнопками; 

o якщо клацнути на об’єкт правою кнопкою миші, з’являється 

контекстна панель інструментів і довший список параметрів дій; 

o швидке подвійне клацання по папці розкриває її, а по елементу 

моделювання – показує його розміри; 

o повільне подвійне клацання по елементу моделювання дозволяє 

перейменувати його; 

o у разі виконання всіх цих дій підсвічується відповідний елемент у 

Graphics Area (якщо елемент існує там). 

View (Heads-up) Toolbar розташовано прямо під панеллю 

інструментів безпосередньо на Graphics Area та керує виглядом 

відображення моделі (рисунок 1.9). Основними елементами View (Heads-

up) Toolbar є Zoom Options (масштабування), Section View (створення 

розрізів моделі), View Orientation (зміна орієнтації моделі, а саме: 

спереду, справа, зверху, ізометрія та інші), Display Options (зміна стилю 

відображення моделі) та Appearance/Visibility Settings (налаштування 

зовнішнього вигляду та видимості моделі). 
 

 
 

Рисунок 1.9 – Основні елементи View (Heads-up) Toolbar 
 

Graphics Area – це область побудови, де створюється модель та де 

користувач безносередньо взаємодіє з нею. Під час проєктування в 

Graphics Area потрібно оперувати такими параметрами: Vertexes/Points 

(вершини/точки), Edges (ребра), Faces (грані), Planes (площини), Axes 

(осі), Features (елементи) та Bodies (тіла), які пов’язані з моделлю 

(рисунок 1.10). 

Ознайомившись з налаштуваннями та інтерфейсом програми 

SOLIDWORKS доцільно притримуватися згадуваного вище загального 

принципу тривимірного проєктування виробів під час створення 

твердотільних тривимірних моделей. Більш розгорнутий принцип 

тривимірного проєктування виробів наведено в наступному алгоритмі: 

1. Вибір Default Plane (стандартної площини), або Plane (площини, 

яка побудована власноруч), або Face (поверхні деталі, крім криволінійної) 

для розміщення Sketch (ескізу); 
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2. Побудова елементів Sketch із встановленням розмірів і 

визначенням взаємозв’язків, щоб досягти повністю визначеного ескізу [5] 

в Status Bar; 

3. Виконання дії над Sketch для додавання потрібної товщини 

плоскому ескізу (витягування, поворот тощо) через Feature Command 

Manager;  

4. Підтверджуємо створення тривимірної твердотільної моделі та 

повернення на початок цього алгоритму для створення нового елемента 

виробу. 

 

 
 

Рисунок 1.10 – Основні параметри Graphics Area 

 

1.2 Порядок виконання роботи 

 

1. Ознайомтесь з теоретичними відомостями до лабораторної 

роботи. 

2. В звіт внести тему та мету роботи. 

3. На занятті в лабораторії переглянути основні налаштування 

програми SOLIDWORKS, потренуватися створювати довільні тривимірні 

моделі, ознайомитися з панеллю інструментів та зберегти результати. 

4. Пройти тест до лабораторної роботи № 1 в системі JetIQ 

Вінницького національного технічного університету (ВНТУ). 

5. Вказати відповіді на контрольні питання. 

6. Завершити виконання звіту до лабораторної роботи формуванням 

висновків. У висновках вказати основні функції та можливості програми 

SOLIDWORKS, які використовували у процесі виконання лабораторної 

роботи. 
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1.3 Контрольні питання 

 

1. Яке призначення програми SOLIDWORKS? 

2. В чому різниця між налаштуваннями параметрів користувача та 

параметрів документів? 

3. Структура меню програми SOLIDWORKS. 

4. Як налаштувати сітку в ескізах і навіщо вона потрібна? 

5. Які етапи загального принципу тривимірного проєктування 

виробів розглянуто в лабораторній роботі? 
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ЛАБОРАТОРНА РОБОТА № 2 

 

ПОБУДОВА ЕСКІЗІВ ІЗ ВИКОРИСТАННЯМ ВЗАЄМОЗВ’ЯЗКІВ 

 

 

Мета роботи. Вивчення методів побудови елементів ескізів, 

способів розставлення розмірів і визначення взаємозв’язків між 

елементами в системі автоматизованого проєктування SOLIDWORKS. 

 

2.1 Короткі теоретичні відомості 

 

Виконання лабораторної роботи № 2 заплановано на креслениках 

формату А3 без рамки та основного напису. Цей формат потрібно 

налаштувати після вибору шаблону Drawing на рисунку 1.2. Далі 

викликаємо контекстне меню елемента Sheet1 у Feature Manager Design 

Tree та вибираємо Properties… В результаті з’явиться вікно Sheet 

Properties, в якому потрібно провести аналогічні налаштування та вказати 

Custom sheet size: 420×297 mm. 
 

 
 

Рисунок 2.1 – Налаштування формату кресленика 
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Параметри налаштування шаблону Drawing залишаємо за 

замовчуванням. В такому разі Overall drafting standard має відповідати 

параметру GOST. Переглянути налаштування можна за шляхом: Tools ⇒ 

Options ⇒ Document Properties ⇒ Drafting Standart. 

Потрібно розрізняти поняття «повністю визначений» та 

«недовизначений» ескіз [5]. Повністю визначеним ескізом називають 

такий, у якого всі лінії і криві, а також їх розташування однозначно 

описані розмірами і (або) взаємозв’язками. Колір елементів ескіза – 

чорний. 

Недовизначений ескіз має не проставлені, або не визначені деякі 

розміри чи взаємозв’язки. У такому разі колір елементів ескізу – синій. 

Щоб відслідковувати визначеності ескізу потрібно налаштувати 

шари. При цьому викликаємо контекстне меню області побудови правою 

кнопкою миші та вибираємо команду Change Layer. Для вибраної 

команди у вікні Change document layer вибираємо вкладку Per Standard 

(рисунок 2.2) та продовжуємо проєктування. 
 

 
 

Рисунок 2.2 – Налаштування шарів для ескізів кресленика 

 

Результат побудови повністю визначеного ескізу показано на 

рисунку  2.3, а. Недовизначений ескіз продемонстровано на рисунку 2.3, б, 

де не вистачає вказання висоти прямокутника та верхня лінія підсвічується 

синім кольором. 

 

 
а      б 

 

Рисунок 2.3 – Результат побудови повністю визначеного (а) та 

недовизначеного (б) ескізів 

 

Щоб побудувати геометричні елементи на ескізі кресленика, можна 

використовувати вкладку Sketch на панелі інструментів. Основні 
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інструменти ескізу показані на рисунку 2.4: Constrains geometry 

dimensionally, Creations Tools, Modification Tools та Relation Tool. 
 

 
 

Рисунок 2.4 – Основні інструменти вкладки Sketch 

 

У процесі побудови ліній, дуг, багатокутників тощо потрібно 

орієнтуватися на спеціальні елементи формування ескізу: Formation Lines, 

Cursor View, Relations (рисунок 2.5). Елементи формування динамічно 

змінюються та показують, як попередні побудови ескізу впливають на 

наступні побудови. 
 

 
 

Рисунок 2.5 – Основні елементи формування ескізу 

 

Елементи побудови ескізу розташовані у вкладці Sketch в розділі 

Creation Tools [2–4]. До основних елементів Creation Tools для ескізів 

належать: лінія (Line) ; коло (Circle) ; прямокутник (Rectangle) ; 

дуга (Arc) ; проріз (Slot) ; багатокутник (Polygon) ; складна 

крива (Spline) ; еліпс (Ellipse) , точка (Point) та інші фігури. 

Найчастіше використовуваним елементом у разі розробки ескізів є 

Line. На рисунку 2.6, a показано налаштування PropertyManager, де 

встановлено один із Orientation лінії: As sketched, Horizontal, Vertical, 

Angle. На рисунку 2.6, б показано послідовність побудови лінії: 

натискаємо в позиції 1 лівою кнопкою миші (це буде початок лінії), ведемо 

курсор миші вправо (орієнтуючись на довжину Length, кут нахилу Angle 

та можливий взаємозв’язок Horizontal Relation), натискаємо в позиції 2 
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знову лівою кнопкою миші (це буде кінець лінії). Вийти з режиму 

створення Line, як і з інших режимів створення елементів, виконуємо 

натисканням клавіші Esc на клавіатурі. Побудовану лінію в ескізі показано 

на рисунку 2.6, в. 

 

 
а     б     в 

 

Рисунок 2.6 – Побудова Line на ескізі 

 

Додатково в програмі SOLIDWORKS реалізовано швидкий перехід 

від прямої лінії до дотичної дуги без вибору відповідного інструмента. 

Існує декілька способів такого швидкого переходу. На рисунку 2.7, а та б 

проілюстровано поетапний швидкий перехід від лінії до дуги через 

контекстне мелю за натисканням правої кнопки миші. Крім цього, 

можливий швидкий перехід від лінії до дуги натисканням на клавіатурі 

латинської літери А. 
 

 
   а       б 

 

Рисунок 2.7 – Швидкий перехід від лінії до дуги 
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В програмі SOLIDWORKS передбачено два типи нанесення Circle: 

через центр кола та точку на його дузі (рисунок 2.8, а); або через три точки 

на дузі кола (рисунок 2.8, б). 

Інструмент «Rectangle» дозволяє наносити прямокутники за 

допомогою: двох кутів; центра прямокутника і одного з кутів; або 3 

кутових точок (рисунок 2.9, а). Такий же інструмент також 

використовують для побудови ромба. Наведено приклад використання 

двох кутів як базових точок для побудови прямокутника (рисунок 2.9, б). 
 

  
а     б 

 

Рисунок 2.8 – Методи побудови кола 
 

 
а       б 

 

Рисунок 2.9 – Типи побудови чотирикутників (а) 

та метод побудови прямокутника (б) 

 

Щоб побудувати дугу, в програмі SOLIDWORKS використовують 

один з трьох інструментів: 

 центр дуги «CenterPoint Arc» (рисунок 2.10) – потрібно задати 

координати центра і однієї з крайніх точок, а потім вказати кут дуги (третя 

точка); 

 дотична дуга «Tangent Arc» – команда може застосовуватися для 
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кінцевої точки існуючого елемента. Після її побудови між елементами 

автоматично встановлюється взаємозв’язок дотична (Tangent); 

 дуга через три точки «3 Point Arc» – вимагає вказання двох 

крайніх точок дуги, а шляхом переміщення третьої встановлюється 

значення радіуса. 

 

 
 

Рисунок 2.10 – Методика побудови дуги 

через інструмент «CenterPoint Arc» 

 

Прорізи в програмі SOLIDWORKS пришвидшують побудову пазів та 

вентиляційних отворів на виконуваних деталях. Існують чотири види 

прорізів: прямий проріз (рисунок 2.11, а), прямий проріз через центральну 

точку (рисунок 2.11, б), проріз по дузі через 3 точки (рисунок 2.11, в), 

проріз по дузі з зазначенням центра (рисунок 2.11, г). 

 

   
  а       б 

  
  в       г 

 

Рисунок 2.11 – Методики побудови прорізів 

 

 



 

23 

Побудова багатокутника виконується інструментом «Polygon». Для 

цього потрібно налаштувати кількість сторін (Number of Sides), вибрати 

вписане (Inscribed circle) чи описане (Circumscribed circle) допоміжне 

коло (рисунок 2.12, а), ввести координати центра вписаного кола (Center X 

та Y Coordinates), радіус вписаного кола (Circle Diameter) та кут 

повороту багатокутника (Angle). Останні три налаштування можна 

виконати курсором миші клацанням в потрібних місцях (рисунок 2.12, б). 

 

  
а      б 

 

Рисунок 2.12 – Налаштування побудови багатокутника  

з вписаним допоміжним колом 
 

В програмі SOLIDWORKS складна крива (Spline) – це основний 

інструмент для побудови складної геометрії ескізів і застосовується у разі 

розробки дизайн-проєктів оригінальних корпусів. Приклад побудови 

складної кривої показано на рисунку 2.13, а. Крім цього, складну криву 

використовують як апроксимувальну криву в інженерних задачах, де 

траєкторія зміни геометрії задається за математичним законом.  

Змінюють форму складної кривої трьома способами: переміщенням 

вузла; змінюючи радіальний напрям дотичної – кут нахилу до 

координатної осі (рисунок 2.13, б); змінюючи величину дотичної – радіус 

кривизни у вибраній точці. 

Побудову еліпса (Ellipse) в ескізі виконують за допомогою трьох 

точок: визначають центр розміщення еліпса та радіус горизонтальної осі 

«Radius of the horizontal axis» (рисунок 2.14, а), потім визначають радіус 

вертикальної осі «Radius of the vertical axis» (рисунок 2.14, б). 

Крім звичайного еліпса в програмі SOLIDWORKS є можливість 

побудувати частину еліпса (Partial Ellipse), параболу (Parabola) та 

конічний перетин (Conic). 
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а      б 

 

Рисунок 2.13 – Побудова (а) та редагування (б) складної кривої (Spline) 
 

 
а         б 

 

Рисунок 2.14 – Побудова еліпса 
 

В програмі SOLIDWORKS також передбачено побудову точки 

(Point) в ескізі. Її побудову зазвичай виконують за рахунок позиціонування 

курсора в потрібному місці і натискання лівої кнопки миші. 

Геометричні елементи, побудовані за допомогою Creation Tools, 

потрібно визначити в просторі. Визначення геометричних елементів 

описується математично за рахунок нанесення розмірів, або за рахунок 

накладення взаємозв’язків на їх розташування. Основні елементи 

Constrains geometry dimensionally (див. рисунок 2.4) забезпечують 

нанесення розмірів (рисунок 2.15) на ескізі [2, 3]. Нанесеним розмірам на 

ескізі присвоюються параметри, які потім можна використовувати для 

параметризації спроєктованих елементів. 

За допомогою інструмента Smart Dimension  наносять більшість 

розмірів для елементів ескіза [2]: 

- якщо клацнути на один елемент ескіза, то буде встановлено 

розмір довжини лінії (рисунок 2.16, а), діаметра кола (рисунок 2.17, а) або 

радіуса дуги (рисунок 2.17, б); 

- якщо клацнути на два елементи ескіза, то буде визначено 

відстань між цими двома лініями, двома колами, двома дугами, двома 

точками (рисунок 2.16, б) або їх комбінацією; 

- якщо клацнути на кінцевих точках дуги та кривій цієї дуги, то 

визначиться довжина лінії дуги (рисунок 2.18); 
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- якщо клацнути центральну лінію та лінію (рисунок 2.19), 

паралельну їй, або точку, то відстань між елементом і центральною лінією 

буде подвоєна, щоб імітувати діаметр або симетрію, які ще не створені; 

- якщо клацнути на двох непаралельних лініях, то визначиться кут 

між ними. 
 

 
 

Рисунок 2.15 – Типи розмірів спадного списку Constrains geometry 

dimensionally 

 

  
а     б 

 

Рисунок 2.16 – Нанесення лінійних розмірів 
 



 

26 

   
а     б 

 

Рисунок 2.17 – Нанесення розмірів діаметра кола та радіуса дуги 
 

    
а       б 

 

Рисунок 2.18 – Метод нанесення розміру довжини дуги 
 

 
 

Рисунок 2.19 – Нанесення розмірів відносно центральної лінії 
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На рисунку 2.4 було показано основні інструменти для модифікації 

ескізу (Modification Tools) [2, 3]. Все, що роблять ці інструменти, можна 

зробити іншими способами, але використання цих інструментів набагато 

пришвидшує роботу інженера-конструктора. До Modification Tools 

відносять: обрізку об’єктів (Trim Entities), зміщення об’єктів (Offset 

Entities), дзеркало об’єктів (Mirror Entities), масив за лінійним ескізом 

(Linear Sketch Pattern) та інші інструменти. 

Обрізка об’єктів (Trim Entities) використовується для 

стирання / видалення елементів ескізу, які знаходяться між іншими 

елементами. Існують декілька видів стирання / видалення елементів ескізу: 

потужна обрізка (Power Trim), кут (Corner), обрізка всередину (Trim 

Away Inside), обрізна назовні (Trim Away Outside), обрізка до 

найближчого (Trim to Closed). Приклад використання Power Trim 

показано на рисунку 2.20). Power Trim – це найпоширеніший спосіб 

використання Trim Entities. Процедура використання така: клацнути 

лівою кнопкою миші на початку шляху видалення елемента, перетягуючи 

курсор миші між лініями, які потрібно видалити, та відпустити ліву кнопку 

миші. У висхідному меню Trim Entities також є параметр «продовжити 

об’єкт» (Extend Entities). Extend Entities дозволяє продовжити вибрані 

елементи до найближчого перетину з вже існуючим елементом. 
 

 
а      б 

 

Рисунок 2.20 – Стирання частини ескізу за допомогою Power Trim 

 

У процесі зміщення об’єктів (Offset Entities) вибираєте об’єкти 

ескізу щоб копіювати у вибраному напрямку на певну дистанцію 

(рисунок 2.21). 

Зазвичай Offset Entities використовують для створення еквідистанти 

певного профілю об’єкта для інших програм САПР. Для налаштування 

еквідистанти використовують параметри: додати розміри (Add 

Dimensions), відстань від оригінального до зміщеного об’єкта (Offset 
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Distance), зміна положення зміщеного об’єкта (Reverse), вибрати весь 

об’єкт чи його елементи (Select Chain), побудова еквідистанти всередині 

та зовні об’єкта (Bi-directional) й інші. 

 

 
 

Рисунок 2.21 – Приклад використання інструмента «Offset Entities» 

 

Дзеркало об’єктів (Mirror Entities) створює копію виділених 

об’єктів відносно лінії віддзеркалення шляхом «перевертання» орієнтації 

об’єкта на основі ефекту дзеркала. Для виконання Mirror Entities потрібно 

обов’язково вказати одну з ліній віддзеркалення: основну (Line), 

допоміжну (Centerline), лінію ребра моделі або лінію ребра на кресленику. 

Якщо дезактивувати функцію копіювання (Copy) на час віддзеркалення 

об’єкта, то об’єкт, який віддзеркалюють, видалиться. 

Масив за лінійним ескізом (Linear Sketch Pattern) використовується 

інженерами нечасто через наявність аналогічного інструмента в 

тривимірному моделюванні. Однак Linear Sketch Pattern стане в пригоді 

для копіюванні елементів ескізу відносно лінії. Використовуючи 

PropertyManager відбувається: налаштування елементів Linear Sketch 

Pattern: кількість екземплярів (Number of Instances), напрямок 

(Direction 1) / (Direction 2) і відстань(Spacing) (рисунок 2.22). 

Масив по круговому ескізу (Circular Sketch Pattern) знаходиться в 

спадному меню для Linear Sketch Pattern, та призначений для побудови 

шаблонів відносно вибраної точки або кола. 

Встановлення взаємозв’язків елементів на ескізі виконується за 

рахунок Relation Tool (див. рисунок 2.4). Взаємозв’язки – це логічні 

операції, за допомогою яких встановлюються відносини між елементами 

ескізу, площинами, осями, кромками або вершинами. Взаємозв’язки, 

накладені на елементи ескізу, мають своєю метою втілення 

конструкторського задуму та зменшення кількості нанесених розмірів. 

Взаємозв’язки обмежують ступінь вільності елементів ескізу. 
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Рисунок 2.22 – Налаштування PropertyManager для Linear Sketch Pattern 
 
На рисунку 2.23 показано кнопки відображення та додавання 

взаємозв’язків через вкладку Sketch панелі інструментів. Найчастіше 

використовуються такі взаємозв’язки: горизонтальність (Horizontal) ; 

колінеарність (Colinear) ; корадіальність (Coradial) ; 

перпендикулярність (Perpendicular) ; паралельність (Parallel) ; 

дотичність (Tangent) ; вертикальність (Vertical) ; концентричність 

(Concentric) ; злиття точок (Merge) ; збіг (Coincident) ; рівність 

(Equal) ; симетричність (Symmetric) ; фіксація (Fix) . Їхні назви 
відповідають наявним функціям у процесі встановлення взаємозв’язків. 

 

 
 

Рисунок 2.23 – Додавання взаємозв’язків через Add Relations 

на панелі Sketch 
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Додавати взаємозв’язки також можна за допомогою контекстного 

меню при натисканні лівої кнопки миші. Наприклад (рисунок 2.24), 

показано можливі взаємозв’язки для точки на кресленику. Для фіксації 

вигляду кресленика зазвичай використовують центр системи координат 

або задають одну нерухому точку взаємозв’язком Make Fixed. 

Зловживання взаємозв’язком Make Fixed може призвести до порушення 

роботи параметричних розмірів та виникнення помилок. 

 

 
 

Рисунок 2.24 – Додавання взаємозв’язків через контекстне меню 

лівої кнопки миші 
 

Налаштування взаємозв’язків елементів ескізу також проводять 

через властивості цих елементів. Частину властивостей Line Properties 

показано на рисунку 2.25. Пропозиція щодо встановлення нових 

взаємозв’язків подана в розділі Add Relations для конкретного елемента 

або групи елементів ескізу. Щоб накласти взаємозв’язок на два або більше 

елементів, як мінімум один з них має бути елементом цього ескізу. Інші 

елементи можуть бути також елементами цього ескізу, кромками, гранями, 

вершинами, початками координат, площинами або осями. У взаємозв’язку 

можуть також брати участь криві, що належать іншим ескізам, якщо при 

проєктуванні на площину даного ескізу вони утворять лінії або дуги. 

Наприклад, для лінії передбачено можливість додавання горизонталі 

(Horizontal), вертикалі (Vertical) або фіксації (Fix). Тип взаємозв’язку, що 

найбільше підходить для виділених об’єктів, виділяється жирним 

шрифтом. 

Переглянути встановлені взаємозв’язки для кожного елемента ескізу 

можна в розділі Existing Relations. Наприклад, на рисунку 2.25 показано 

три встановлені взаємозв’язки: горизонтальний (Horizontal), колінеарний 

(Colinear) та перпендикулярний (Perpendicular). Ці взаємозв’язки 

стосуються конкретної лінії з іншими елементами ескізу. 

Приклад позначення та використання взаємозв’язків на ескізі 

показано на рисунку 2.26. Якщо під час додавання розмірів або 

взаємозв’язків до ескізу постійно виникає попередження про 

перевизначеність, то потрібно перевірити ескіз на наявність небажаних 

взаємозв’язків. 
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Рисунок 2.25 – Відображення частини властивостей Line Properties 

 

 
 

Рисунок 2.26 – Приклад використання взаємозв’язків 

 

Щоб видалити взаємозв’язки, потрібно виділити відповідну 

піктограму взаємозв’язку на ескізі та натиснути клавішу Delete на 
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клавіатурі. Це можна також зробити, виділивши елемент ескізу (лінію або 

точку) і в розділі Existing Relations на панелі PropertyManager видалити 

відповідний взаємозв’язок (клавішею Delete на клавіатурі). 

 

2.2 Завдання для виконання лабораторної роботи № 2 

 

В завданні до лабораторної роботи № 2 підготовлено 30 

індивідуальних варіантів. Якщо кількість здобувачів в групі більша, ніж 

підготовлених завдань, то потрібно звернутися до викладача, щоб він 

видав додаткові варіанти завдання. 

У процесі виконання завдання на форматі А3 здобувачі проєктують 

повністю визначений ескіз з використанням розмірів та взаємозв’язків. 

Після виконання завдання кожний здобувач підписує роботу 

вказавши її назву, назву своєї групи, прізвища розробника і перевіряючого. 
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2.3 Порядок виконання роботи 

 

1. Ознайомитись з теоретичними відомостями до лабораторної 

роботи. 

2. В звіт занести тему та мету роботи. 

3. Ознайомитися з описом роботи та завданням. 

4. Відповідно до виданого варіанта завдання виконати побудову 

ескізу на форматі А3 в програмі SOLIDWORKS. Зокрема нанести на всі 

елементи ескізу таку кількісті розмірів, яка не перевищує їх наявну 

кількість в завданні.  

5. За рахунок додання взаємозв’язків повністю визначити ескіз (за 

винятком взаємозв’язків Fix). Максимальна кількість взаємозв’язків Fix не 

має перевищувати 1. 

6. Вказати відповіді на контрольні питання. 

7. Завершити виконання звіту для лабораторної роботи 

формуванням висновків. У висновках вказати інструменти програми 

SOLIDWORKS, які вдалося опанувати в процесі виконання лабораторної 

роботи. Вказати скільки та які взаємозв’язки вдалося використати для 

досягнення повної визначеності ескізу. 

 

2.4 Контрольні питання 

 

1. Чим відрізняється повністю визначений та недовизначений 

ескізи? 

2. Який елемент для побудови ескізу є найбільш 

використовуваним? 

3. Скільки методів побудови кола в програмі SOLIDWORKS? 

Опишіть методи побудови кола. 

4. Як нанести розмір довжини дуги? 

5. Які види взаємозв’язків найчастіше використовуються? 
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ЛАБОРАТОРНА РОБОТА № 3 

 

СТВОРЕННЯ ТВЕРДОТІЛЬНИХ ТРИВИМІРНИХ МОДЕЛЕЙ 

ДЕТАЛЕЙ 

 

 

Мета роботи. Вивчення основних методів побудови тривимірних 

моделей деталей в системі автоматизованого проєктування SOLIDWORKS. 

 

3.1 Короткі теоретичні відомості 

 

Левову частку тривимірних моделей в машинобудуванні складають 

твердотільні. Твердотільне моделювання – це проєктування тіл, які мають 

всі ознаки фізичного тіла [4]. У разі твердотільного моделювання 

користувач створює одразу оболонки, які відокремлюють внутрішній 

простір об’єкта від всього іншого простору. Варто зауважити, що процес 

твердотільного моделювання оболонки об’єкта аналогічний процесу його 

виготовлення. 

Основними інструментами для побудови тривимірної моделі на 

вкладці Features (рисунок 3.1) на панелі інструментів використовують 

такі [2]: видавлювання (Extruded Boss/Base) , обертання (Revolved 

Boss/Base) , побудова елемента за траєкторією (Swept Boss/Base) , 

побудова елемента за перерізами (Lofted Boss/Base) , побудова на межі 

поверхні (Boundary Boss/Base) . Найбільш поширені методи для 

створення першого елемента тривимірної моделі – Extruded Boss/Base та 

Revolved Boss/Base. На базі основного елемента побудови виконують 

аналогічні, або інші операції для розбудови усієї тривимірної моделі. 
 

 
 

Рисунок 3.1 – Вкладка Features на панелі інструментів 

 

Інструмент побудови видавлюванням (Extruded Boss/Base) створює 

третій вимір елемента шляхом витягування двовимірного ескізу в 

перпендикулярному напрямку до нього. Основними налаштування на 

панелі PropertyManager (рисунок 3.2) для Extruded Boss/Base є: 

початкова умова (Start Condition), зворотний напрямок (Reverse 

Direction), кінцева умова (End Condition), напрямок видавлювання 

(Direction of Extrusion), глибина видавлювання (Depth of Extrusion), 

увімкнути / вимкнути ухил (Draft On/Off), кут ухилу (Draft Angle), 

напрямок 2 (Direction 2) та інші. 
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Рисунок 3.2 – Налаштування панелі PropertyManager 

для Extruded Boss/Base 

 

На основі двовимірного ескізу кола діаметром 100 мм використано 

інструмент Extruded Boss/Base. Фантомне зображення тривимірної моделі 

циліндра шляхом видавлювання на глибину 100 мм показано на рисунку 

 3.3, а. Після підтвердження налаштувань в результаті отримано 

твердотільну тривимірну модель циліндра (рисунок 3.3, б). 
 

  
  а      б 

 

Рисунок 3.3 – Налаштування фантомного зображення тривимірної моделі 

циліндра шляхом видавлювання (а) та результат твердотільного 

моделювання циліндра (б) 

 

Інструмент побудови обертанням (Revolved Boss/Base) створює 

елемент, який додає матеріал шляхом повороту одного або кількох Sketch 
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навколо осьової лінії (Centerline / Axe of Revolution). У процесі Revolved 

Boss / Base використовують такі налаштування (рисунки 3, 4): вісь 

обертання (Axe of Revolution), зворотний напрямок (Reverse Direction), 

тип обертання (Revolve Type), кут обертання (Direction Angel). Створені 

елементи після використання інструмента Revolved Boss/Base можуть 

бути твердотільними, тонкостінними або поверхнею.   
 

 
 

Рисунок 3.4 – Налаштування панелі PropertyManager 

для Revolved Boss / Base 

 

На основі двовимірного ескізу деталі з Centerline / Axe of Revolution 

показано її фантомне зображення (рисунок 3.5, а) та готову тривимірну 

модель деталі, виконану з Direction Angel на 360o (рисунок 3.5, б). Після 

перелаштування Direction Angel на 270o отримано твердотільну 

тривимірну модель деталі з відсутньою її четвертиною (рисунок 3.5, в). 

 

   
а    б    в 

 

Рисунок 3.5 – Фантомне зображення (а) та готова тривимірна модель (б) 

деталі, виконана на 360o, а також готова тривимірна модель (в) деталі, 

виконана на 270о 

 

Інструмент побудови елемента за траєкторією (Swept Boss / Base) 

створює основу або поверхню шляхом переміщення профілю 

(Profile(Sketch3)) у напрямку побудованої траєкторії (Profile(Sketch1)). На 
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рисунку 3.6 показано поетапне виділення Profile(Sketch3) та 

Profile(Sketch1) для створення фантомного зображення тривимірної 

моделі. 
 

 
 

Рисунок 3.6 – Вибір основи та траєкторії для побудови елемента  

за траєкторією (Swept Boss/Base) 

 

Інструмент побудови елемента за перерізами (Lofted Boss/Base) 

створює елемент шляхом моделювання переходів між профілями (Sketch). 

На рисунку 3.7 показано поетапне виділення ескізів для створення 

фантомного зображення тривимірної моделі і результат твердотільного 

моделювання. 
 

 
 

Рисунок 3.7 – Створення тривимірної моделі шляхом побудови елемента за 

перерізами (Lofted Boss/Base) 
 

Інструмент побудови на межі поверхні (Boundary Boss/Base) 

створює високоякісні та точні елементи, потрібні для створення складних 
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форм деталі у разі проєктування продуктів широкого споживання, 

медичних виробів, деталей для аерокосмічної промисловості та ливарного 

виробництва. 

Усі розглянуті вище інструменти та методи побудови елементів 

деталі мають інструменти та методи з оберненою функцією – вирізання. 

Існують такі інструменти вирізання: вирізання видавлюванням (Extruded 

Cut) , вирізання обертанням (Revolved Cut) , вирізання елемента за 

траєкторією (Swept Cut) , вирізання елемента за перерізами (Lofted 

Cut) , вирізання на межі поверхні (Boundary Cut) . Набір 

властивостей в PropertyManager для однойменних інструментів 

видавлювання та вирізання – однаковий. Вони працюють аналогічно 

попередньо згаданим інструментам, але забезпечують вирізання наявного 

матеріалу тривимірної моделі. 

Інструменти нанесення отворів Hole Wizard  та Advanced Hole 

 (рисунок 3.8) забезпечують тривимірне моделювання елементів 

простих та ступінчастих отворів. Причому, інструмент Hole Wizard в своїх 

налаштуваннях має вже сформовані розроблені типи отворів (рисунок 3.9), 

а інструмент Advanced Hole дозволяє створювати ступінчастий отвір 

згідно з потребами користувача. 

На рисунку 3.9 показано послідовність налаштування параметрів для 

створення ступінчастого отвору за допомогою інструмента Hole Wizard 

[2]. А на рисунку 3.10 показано послідовність дій для позиціонування на 

поверхні деталі створеного ступінчастого отвору. 
 

 
 

Рисунок 3.8 – Спадний список з інструментами Hole Wizard,  

Advanced Hole, Tread та Stud Wizard 

 

Для реальної побудови внутрішніх і зовнішніх різей використовують 

інструменти Thread  (рисунок 3.8). Причому, для побудови внутрішніх 

чи зовнішніх різей обов’язково має бути сформована їх циліндрична 

поверхня.  

Однак під час побудови різей перевагу віддають не реальній 

побудові за допомогою інструмента Thread, а умовному зображенню різей 
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за допомогою інструмента Cosmetic Thread (рисунок 3.11, а). Це 

зумовлено виконанням умовного позначення різі на кресленику (рисунок 

3.11, б). Шлях до інструмента Cosmetic Thread: Insert ⇒ Annotations ⇒ 

Cosmetic Thread.  

 

 
 

Рисунок 3.9 – Налаштування вигляду ступінчастого отвору за допомогою 

інструмента Hole Wizard 
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Рисунок 3.10 – Позиціонування ступінчастого отвору 
 

  
  а     б 

 

Рисунок 3.11 – Особливості виконання реального та умовного зображень 

різі на тривимірній моделі (а) та кресленику (б) 

 

Для створення шпильок на поверхнях деталей використовують 

інструмент Stud Wizard  (див. рисунок 3.8). Налаштування інструмента 

Stud Wiza дозволяють на вже існуючій циліндричній поверхні додати 

поверхню з різзю (Creates Stud on a Cylindrical Body), або почати 

створювати елементи шпильки на плоскій поверхні (Creates Stud on a 

Surface). 

До типових елементів твердотільного моделювання належать такі 

елементи [2]: округлення (Fillet) , фаска (Chamfer) , оболонка 

(Shell) , ребро (Rib)  та нахил (Draft) . 

Більш детально про використання типових елементів твердотільного 

моделювання подано в посібнику [2]. На рисунках 3.12–3.16 показано 
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налаштування під час застосування типових елементів твердотільного 

моделювання, а також отриманий результат. 

Інструмент Fillet зазвичай використовують для позначення ливарних 

радіусів для виливок, галтельних переходів для валів, округлих поверхонь 

деталі тощо. 

Інструмент Chamfer та Rib застосовують, в основному, за 

однойменним призначенням, відповідно, це тривимірне моделювання 

фасок та ребер деталі. 

Інструмент Shell дуже зручний для виконання оболонок за формою 

зовнішньої поверхні. Тут задається лише товщина створюваної деталі. 

Нахили поверхонь можна виконувати безпосередньо під час 

використання основних інструментів вкладки Features (див. рисунок 3.2). 

Але існує спеціальний інструмент Draft, який дозволяє виконати нахили 

поверхонь вже після побудованої твердотільної тривимірної моделі. 
 

 
 

Рисунок 3.12 – Приклад використання інструмента Fillet 
 

 
 

Рисунок 3.13 – Приклад використання інструменту Chamfer 
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*  
 

Рисунок 3.14 – Приклад використання інструмента Shell 
 

 
 

Рисунок 3.15 – Приклад використання інструмента Rib 
 

 
 

Рисунок 3.16 – Приклад використання інструмента Draft 
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Інструменти масивів і відображення дозволяють пришвидшити 

побудову поверхонь та елементів тривимірної моделі (рисунок 3.17): 

лінійний масив (Linear Pattern), круговий масив (Circular Pattern), 

відображення (Mirror), масив по кривій (Curve Driven Pattern) та інші. 

Достатньо виконати в розмірах лише один елемент деталі, і за допомогою 

масивів провести їх копіювання згідно з певним напрямком, віссю чи 

траєкторією. 

Приклад використання інструмента Linear Pattern показано на 

рисунку 3.18 [2]. Моделюємо в 2-х напрямках по 6 виступів із кроком 

25 мм. Ці виступи заповнюють всю площину 150×150 мм. 

Найбільш популярний інструмент Circular Pattern для копіювання 

елемента циліндричного отвору по колу у виробах із кріпильними 

отворами. На рисунку 3.19 [2] продемонстровано етапи налаштування 

масиву отворів по колу в 360о та кількістю 9 штук. 
 

 
 

Рисунок 3.17 – Інструменти створення масивів та відображення 

у процесі тривимірного моделювання 

 

Дзеркальне відображення елементів деталі дозволяє пришвидшувати 

побудову за рахунок того, що потрібно задати розміри лише половини 

деталі. Послідовність налаштування інструмента відображення (Mirror) 

показана на рисунку 3.20 [2]. Однак такий метод тривимірного 

моделювання елементів не підходить для несиметричних деталей. 
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Рисунок 3.18 – Налаштування для копіювання елемента циліндричного 

виступу за допомогою інструмента  

лінійний масив (Linear Pattern) 

 

 
 

Рисунок 3.19 – Налаштування для копіювання елемента циліндричного 

отвору за допомогою інструмента круговий масив (Circular Pattern) 
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Рисунок 3.20 – Налаштування для дзеркального відображення половини 

деталі за допомогою інструмента відображення (Mirror) 
 

Інші закономірності, за якими наведено варіанти побудови масивів 

елементів деталі в SOLIDWORKS, подані під інструментом Mirror (див. 

рисунок 3.17). Основні налаштування для інструмента масиву по кривій 

(Curve Driven Pattern) показано на рисунку 3.21 [2]. В результаті 

побудови маємо отримати 11 штук виступів, які будуть розподілені по 

траєкторії кривої з кроком 35 мм. 
 

 
 

Рисунок 3.21 – Налаштування для копіювання елемента циліндричного 

виступу по вказаній траєкторії за допомогою  

інструмента масив по кривій (Curve Driven Pattern) 
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Усталене налаштування в SOLIDWORKS у процесі створення 

документа Part передбачає створення 3-х основних площин і центра 

координат. Усі інші побудови додаткових елементів виконуються шляхом 

використання інструментів допоміжної геометрії (Reference Geometry) та 

показані на рисунку 3.22, а: площина (Plane) , осі (Axes) , центр 

координат іншої системи (Coordinate System) , точка (Point)  та інші. 

Доцільність використання додаткової геометрії залежить від 

конструкції деталі. Наприклад, у разі побудови деталі інструментом Lofted 

Boss/Base мають бути застосовані додаткові Plane, на яких будуть створені 

інші ескізи перерізу деталі. 

За створення додаткових кривих (Curves) (рисунок 3.22, б), які 

допомагають побудові тривимірної моделі, відповідають такі інструменти: 

роздільна лінія (Split Line) , проєкційна крива (Project Curve) , 

складна крива (Composite Curve) , крива через точки XYZ (Curve 

Through XYZ Points) , крива через опорні точки (Curve Through 

Reference Points)  та гвинтова лінія чи спіраль (Helix and Spiral) . 

Більш детально про їх застосування можна ознайомитися в посібнику [2]. 
 

  
а      б  

 

Рисунок 3.22 – Інструменти допоміжної геометрії (а) та кривих (б) 

 

3.2 Завдання до виконання лабораторної роботи № 3 

 

Завдання до лабораторної роботи № 3 складається з двох частин для 

30 індивідуальних варіантів. Перша частина завдання охоплює 

проєктування твердотільних тривимірних моделей двох різних фігур 

згідно з отриманим варіантом завдання. Фігури першої частини завдання є 

нескладними геометричними фігурами з наскрізними отворами різної 

конструкції. У процесі побудови фігур першого завдання як першу 

операцію, в основному, буде використано інструмент Extruded Boss/Base, 
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а для випадків зі зрізаним конусом – інструменти Revolved Boss / Base або 

Swept Boss/Base. 

Друга частина завдання містить проєктування твердотільної 

тривимірної моделі ступінчастого вала за отриманим варіантом завдання 

згідно з вихідними даними. Оскільки ступінчастий вал – це тіло обертання, 

то перша операція для його побудови – це Revolved Boss / Base, а всі 

наступні операції можна виконати за допомогою інструментів вирізання та 

Hole Wizard. 

Якщо кількість здобувачів в групі більша, ніж підготовлених 

варіантів завдань, то потрібно звернутися до викладача за додатковими 

варіантами. 

У процесі виконання завдання здобувачі проєктують повністю 

визначені ескізи з використанням розмірів та взаємозв’язків. 

3.2.1 Перша частина завдання до лабораторної роботи № 3 
 

Варіант 1 

 
Варіант 2 
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Варіант 3 

 
Варіант 4 

 
Варіант 5 
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Варіант 6 

 
 

Варіант 7 

 
Варіант 8 
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Варіант 9 

 
Варіант 10 

 
Варіант 11 
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Варіант 12 

 
Варіант 13 

 
Варіант 14 
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Варіант 15 

 
Варіант 16 

 
Варіант 17 
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Варіант 18 

 

Варіант 19 

 
Варіант 20 
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Варіант 21 

 
Варіант 22 

 
Варіант 23 
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Варіант 24 

 
Варіант 25 

 
Варіант 26 
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Варіант 27 

 

Варіант 28 

 
Варіант 29 
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Варіант 30 

 
 

3.2.2 Друга частина завдання до лабораторної роботи № 3 
 

 
 

Рисунок 3.23 – Друга частина завдання для лабораторної роботи № 3 
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Таблиця 3.1 – Параметри деталі, яку показано на рисунку 3.23 

В
а
р

іа
н

т
 

L
1
 

L
2
 

L
3
 

L
4
 

L
5
 

L
6
 

L
7
 

D
1
 

D
2
 

D
3
 

D
4
 

H
1
 

H
2
 

H
3
 

R
1
 

F
1
 

1 100 30 20 24 10 10 20 40 65 35 8 4 24 28 3 1,5 

2 120 35 25 28 10 14 18 45 70 40 10 5 28 30 4 1,5 

3 110 25 35 30 12 8 20 38 66 50 11 4 46 28 3 1,5 

4 120 32 22 26 12 11 22 44 68 36 12 5 30 30 4 1,5 

5 120 34 20 30 12 10 25 48 68 43 13 5 38 29 3 1,5 

6 130 36 22 30 12 10 25 50 70 45 13 6 38 29 4 1,5 

7 135 38 21 30 13 11 28 52 72 47 14 6 42 30 4 1,5 

8 140 38 23 35 13 11 28 50 65 44 15 7 38 27 4 1,5 

9 130 34 21 35 13 8 25 54 74 48 16 7 40 32 4 2,0 

10 140 34 25 35 14 8 28 52 72 47 17 8 40 30 5 2,0 

11 145 36 26 38 14 10 28 56 76 45 18 7 36 32 4 2,0 

12 150 38 25 38 14 10 30 54 74 50 19 8 45 32 5 2,0 

13 140 32 22 38 14 10 30 58 78 52 20 7 45 34 4 2,0 

14 155 40 23 40 14 11 30 56 76 50 20 7 45 34 5 2,0 

15 160 42 23 40 15 11 34 54 74 48 20 7 40 35 5 2,0 

16 150 40 21 40 15 11 32 56 76 52 21 8 42 34 6 2,0 

17 155 42 25 38 15 12 32 58 78 53 21 8 42 35 5 2,5 

18 160 44 23 38 15 12 32 56 76 51 22 9 44 35 6 2,5 

19 165 44 24 38 15 12 35 60 80 55 22 8 48 34 5 2,5 

20 160 42 24 42 16 10 35 58 78 54 23 9 48 34 6 2,5 

21 170 42 25 42 16 10 35 56 76 50 23 9 42 33 6 2,5 

22 165 42 22 42 16 10 37 60 75 52 24 9 42 32 6 2,5 

23 175 44 26 40 16 11 37 62 82 50 24 9 40 36 7 2,5 

24 175 42 24 40 16 10 37 64 84 52 25 8 42 36 6 2,5 

25 160 40 22 40 18 8 40 62 86 57 25 9 44 38 7 3,0 

26 180 46 28 42 18 8 40 60 78 54 26 8 46 36 6 3,0 

27 185 46 30 42 18 12 42 66 86 50 26 9 42 38 7 3,0 

28 190 48 27 42 18 12 42 64 84 59 28 9 48 37 7 3,0 

29 195 50 26 44 20 12 45 68 88 53 28 9 44 37 7 3,0 

30 200 50 30 44 20 14 50 70 90 65 30 9 55 38 7 3,0 

 

3.3 Порядок виконання роботи 

 

1. Ознайомтесь з теоретичними відомостями до лабораторної 

роботи. 

2. В звіті вказати тему та мету роботи. 

3. Ознайомитися з описом роботи та завданням. 

4. Відповідно до виданого варіанта для першої частини завдання 

виконати побудову двох твердотільних тривимірних моделей фігур з 

наскрізними отворами різної конструкції в програмі SOLIDWORKS. Також 

нанести усі необхідні розміри та взаємозв’язки, щоб повністю визначити 

ескізи тривимірних моделей.  
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5. Відповідно до виданого варіанта для другої частини завдання 

виконати побудову твердотільної тривимірної моделей вала в програмі 

SOLIDWORKS. У процесі виконання завдання нанести усі необхідні 

розміри та взаємозв’язки, щоб повністю визначити ескізи тривимірної 

моделі. 

6. Вказати відповіді на контрольні питання. 

7. Завершити виконання звіту до лабораторної роботи формуванням 

висновків. У висновках вказати інструменти програми SOLIDWORKS, які 

вдалося опанувати під час виконання лабораторної роботи. Вказати 

скільки операцій міститься в FeatureManager Design Tree для кожної зі 

створених твердотільних тривимірних моделей. 

 

3.4 Контрольні питання 

 

1. Які основні інструменти для побудови тривимірних моделей 

застосовуються в програмі SOLIDWORKS? 

2. На який максимальний кут можна обертати ескіз деталі 

інструментом Revolved Boss/Base? 

3. Чим відрізняються інструменти нанесення отворів Hole Wizard 

та Advanced Hole? 

4. В чому різниця між виконанням реального та умовного 

зображення різі на тривимірній моделі? 

5. Які типові елементи твердотільного моделювання 

використовують в програмі SOLIDWORKS? 

6. Які інструменти для створення масивів існують в програмі 

SOLIDWORKS? 
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ЛАБОРАТОРНА РОБОТА № 4 

 

ВИКОРИСТАННЯ БІБЛІОТЕК В ТРИВИМІРНОМУ 

МОДЕЛЮВАННІ 

 

 

Мета роботи. Набуття практичних навичок складання стандартних 

різьбових з’єднань і роботи з бібліотеками тривимірних моделей зубчастих 

коліс в програмі SOLIDWORKS. 

 

4.1 Короткі теоретичні відомості 

 

Інструмент (бібліотека) Toolbox в програмі SOLIDWORKS – це 

бібліотека стандартних компонентів і кріплень, що дозволяє швидко та 

просто вставляти типові деталі в розроблювані проєкти [6]. Toolbox має 

широкий асортимент таких стандартних елементів, як болти, гайки, шайби, 

гвинти, пружини, опори, підшипники, зубчасті колеса та інші деталі, що 

використовуються в машинобудуванні та інших галузях. За допомогою 

інструмента Toolbox потрібно лише налаштувати параметри стандартних 

елементів, а саме: розміри, матеріал та інші властивості, відповідно до 

потреб користувача. Це дозволяє інженерам-конструкторам швидко 

створювати складні вироби, скорочуючи час розробки та зменшуючи 

вартість виробництва. 

До бібліотеки Toolbox входить велика кількість стандартних 

елементів різних стандартів і норм, а саме: ANSI, ISO, DIN, JIS, BSI та 

інші. Крім того, користувач може самостійно створювати свої стандартні 

елементи та додавати їх до бібліотеки Toolbox з подальшим 

використанням.  

Для запуску бібліотеки Toolbox при старті програм SOLIDWORKS 

потрібно налаштувати вкладку Add-Ins… (рисунки 4.1 та 4.2, а), або для 

примусового відкриття бібліотеки Toolbox потрібно скористатися Task 

Panes, перейти на вкладку Design Library та обрати Toolbox → Add in 

now (рисунок 4.2, б). 
 

 
 

Рисунок 4.1 – Розміщення кнопки запуску вкладки Add-Ins… 
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а      б 

 

Рисунок 4.2 – Вкладка Add-Ins… (а) та вкладка Design Library (б), де 

налаштовується початок роботи з бібліотекою Toolbox 

 

Вигляд завантаженої бібліотеки Toolbox показано на рисунку 4.3. 

Вона містить папки, в яких розміщено необхідні компоненти відповідних 

стандартів. 
 

 
 

Рисунок 4.3 – Наповнення відповідними стандартами бібліотеки Toolbox 
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Після переходу до папки «ISO» (рисунок 4.4) можна переглянути 

вміст компонентів і вибрати потрібний (наприклад, шайби «Washers», як 

на рисунку 4.5). Усі елементи бібліотеки Toolbox легко модифікуються та 

налаштовуються за потреби. 
 

 
 

Рисунок 4.4 – Вміст папки «ISO» 

 

 
 

Рисунок 4.5 – Різне виконання шайби «Washers» за стандартами ISO 

 

Функція Configure (рисунок 4.6) дозволяє змінювати розміри, 

матеріал та інші параметри елементів під свої потреби. Після 

налаштування елемента з бібліотеки Toolbox, його легко вставляти у 

складальні одиниці Assembly. При додаванні шайби Washers потрібно 

перетягнути її у вікно складальної одиниці Assembly. Далі проводимо 

вибір потрібного розміру шайби Washer. 
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Рисунок 4.6 – Налаштування функції Configure 
 

У процесі додавання стандартних деталей з різьбовою поверхнею 

(болти, гвинти тощо) варто обирати спрощене відображення різі. 

Варто розуміти, що різь – це елемент деталі, утворений 

переміщенням по спіралі плоского контуру (профілю) на циліндричній або 

конічній поверхні [7]. На рисунку 4.7 показано найчастіше 

використовувані профілі різі: а – трикутний, б – трапецеїдальний, в – 

прямокутний. 
 

 
а    б    в 

 

Рисунок 4.7 – Профілі різі: трикутний (а), трапецеїдальний (б) та 

прямокутний (в) 
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Циліндрична різь характеризується виконанням її по поверхні 

циліндра, а конічна різь – по поверхні конуса. Залежно від розміщення 

поверхонь, на яких виконують різі, їх поділяють на зовнішні та внутрішні. 

Зовнішні різьбові поверхні – це виконання різі на зовнішній поверхні 

деталі (болт, гвинт, шпилька тощо), а внутрішні різьбові поверхні – це 

виконання різі на внутрішній поверхні деталі (гайка). 

Основні елементи різі (рисунок 4.8): вісь різі, профіль різі, вершина, 

западина та бічні поверхні профілю різі. 
 

 
 

Рисунок 4.8 – Основні елементи профілю різі 

 

Вісь різі – це вісь, що утворена спіральною (гвинтовою) поверхнею 

різі. 

Профіль різі – це профіль вершин та западин різі у її площині 

осьового перерізу. Між вершинами та западинами профілю розташовані 

бічні поверхні профілю. 

Основні параметри різі (рисунок 4.9): кут профілю різі α, крок різі Р, 

робоча висота профілю Н, зовнішній d та внутрішній d1 діаметри 

зовнішньої і внутрішньої різі, відповідно, d2 – cередній діаметр різі. 
 

 
 

Рисунок 4.9 – Основні параметри різі 

 

Кут профілю різі α – це кут, що виходить з однієї точки між двома 

бічними поверхнями профілю різі у площині осьового перерізу. 

Крок різі Р – це відстань між сусідніми однойменними бічними 

поверхнями профілю різі. 



 

67 

Робоча висота профілю Н – висота профілю між заглибиною і 

вершиною, виміряна в напрямку, перпендикулярному осі різі. 

Зовнішній діаметр d – діаметр уявного циліндра, описаного навколо 

вершин профілю зовнішньої різі або навколо заглибин профілю 

внутрішньої різі, відповідно. Зазвичай вважається номінальним діаметром 

та використовується для позначення різі. 

Середній діаметр d2 – діаметр уявного циліндра, який перетинає її 

витки посередині між вершинами і заглибинами профілю різі. 

Внутрішній діаметр d1 – діаметр уявного циліндра, описаного 

навколо заглибин профілю зовнішньої різі або навколо вершин профілю 

внутрішньої різі, відповідно. 

Основним видом кріпильної різі є метрична. Характерним 

параметром метричної різі є кут профілю α = 60о. Найбільш поширені 

метричні різі з діаметрами від 1 до 600 мм та регламентуються за ДСТУ 

ГОСТ 16093:2018 та ДСТУ ГОСТ 3.1128:2014. В умовне позначення 

метричної різьби входить літера М, номінальний діаметр d, значення кроку 

Р (для різі з  малим кроком), літери LH (тільки для лівої різі) 

(рисунок 4.10). Крім цього, до умовного позначення метричної 

багатозахідної різі додають значення ходу і в дужках літера Р зі значенням 

кроку (наприклад, M20×2 (P1) LH- 8H – внутрішня, двозахідна, з дрібним 

кроком 1 мм і ходом 2 мм, ліва, з полем допуску H та ступенем точності 

різі 8 (для посадок з зазором метричної різі в таблиці 4.1). 
 

 
а       б 

 

Рисунок 4.10 – Умовне позначення метричної різі зовні (а)  

та в отворі (б) 
 

Таблиця 4.1 – Допуски діаметрів метричної різі 

Різь Діаметр різі Ступінь точності Основні відхилення 

Зовнішня 
d 4; 6; 8 d; e; f; g; h 

d2 3; 4; 5; 6; 7 ; 8; 9; 10 d; e; f; g; h 

Внутрішня d2 4; 5; 6; 7; 8; 9 E; F; G; H 

d1 4; 5; 6; 7; 8 E; F; G; H 

 

В таблиці 4.2 наведено діаметри і кроки метричної циліндричної різі 

загального призначення. Зазвичай, діаметрам різі 1-го ряду надають 

перевагу у процесі проєктування. 
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Таблиця 4.2 – Діаметри і кроки метричної циліндричної різі 

загального призначення 

Діаметр різі, мм Крок різі, мм 

1-й ряд 2-й ряд Крупний Дрібний 

6 - 1 0,75; 0,5 

8 - 1,25 1; 0,75; 0,5 

10 - 1,5 1,25; 1; 0,75; 0,5 

12 - 1,75 1,5; 1,25; 1; 0,75; 0,5 

- 14 2 1,5; 1,25; 1; 0,75; 0,5 

16 - 2 1,5; 1; 0,75; 0,5 

- 18 2,5 2; 1,5; 1; 0,75; 0,5 

20 - 2,5 2; 1,5; 1; 0,75; 0,5 

- 22 2,5 2; 1,5; 1; 0,75; 0,5 

24 - 3 2; 1,5; (1) 

- 27 3 2; 1,5; 1; 0,75 

30 - 3,5 (3); 2; 1,5; 1; 0,75 

- 33 3,5 (3); 2; 1,5; 1; 0,75 

36 - 4 3; 2; 1,5; 1 

- 39 4 3; 2; 1,5; 1 

42 - 4,5 (4); 3; 2; 1,5; 1 

- 45 4,5 (4); 3; 2; 1,5; 1 

48 - 5 (4); 3; 2; 1,5; 1 

- 52 5 (4); 3; 2; 1,5; 1 

56 - 5,5 4; 3; 2; 1,5; 1 

- 60 (5,5) 4; 3; 2; 1,5; 1 

64 - 6 4; 3; 2; 1,5; 1 

Примітка. Крок різі, взятий в дужки, при можливості, не 

використовувати. 
 

Створення складальної одиниці виконуємо через шаблон Assembly 

(див. рисунок 1.2). Основні інструменти вкладки Assembly (рисунок 4.11), 

які ми розберемо в рамках вивчення дисципліни «Комп’ютеризовані 

системи проєктування» – це додавання компонентів (Insert Components) 

та накладання пари/сполучення (Mate). 

 

 
 

Рисунок 4.11 – Основні інструменти вкладки Assembly 
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Інструмент Insert Components виконує додавання спроєктованих 

об’єкти, які будуть використовуватись при створенні складальної одиниці. 

Діалогове вікно додавання компонентів показано на рисунку 4.12. 

Потрібно вибрати деталь, яка має належати складальній одиниці, або 

виконати її пошук за допомогою кнопки Browse… 

 

 
 

Рисунок 4.12 – Діалогове вікно додавання компонентів складальної 

одиниці 

 

Першу, успішно додану деталь, зазвичай можна прикріпити до 

вихідної точки поточної складальної одиниці або в довільному місці. 

Наприклад, додана деталь «Верхня пластина» (рисунок 4.13) позначена 

літерою (f) і це означає, що вона зафіксована. У такому разі всі інші деталі 

можуть кріпитися до неї, а для того, щоб зрушити деталь «Верхня 

пластина», потрібно прибрати фіксацію через її контекстне меню. 

Додавання інших деталей до складальної одиниці виконуємо 

інструментом Insert Components, виконуючи аналогічні кроки, як із 

першою деталлю, однак без їх фіксації. 

Копіювання деталей та стандартних елементів в складальних 

одиницях відбувається за допомогою натискання клавіші Ctrl та 

перетягування їх на вільне поле. 

Для редагування або видалення елементів складальної одиниці 

використовують їх контекстне меню. Клацнувши правою кнопкою миші на 

елемент, який потрібно відредагувати або видалити, можна обрати опцію 
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«Open Part» для відкриття його в новому вікні та редагувати, або опцію 

«Delete» для повного видалення його зі складальної одиниці. 

 

 
 

Рисунок 4.13 – FeatureManager Design Tree складальної одиниці Assem1 

 

Для сполучення деталей між собою використовують інструмент 

Mate, який дозволяє встановити взаємозв’язки між різними деталями у 

складальній одиниці. Інструмент Mate забезпечує точне позиціонування та 

взаємодію між деталями. Існують такі пари/сполучення інструмента Mate 

(рисунок 4.14): стандартні (Standard), механічні (Mechanical), розширені 

(Advanced) та для аналізу (Analysis). 
 

 
 

Рисунок 4.14 – Використання інструмента Mate 
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Звернемо увагу лише на стандартні типи сполучень інструмента 

Mate, які будемо використовувати в лабораторній роботі 4: 

• Coincident Mate: дозволяє встановлювати сполучення між двома 

точками, які мають знаходитися в одній точці. 

• Parallel Mate: дозволяє встановлювати сполучення між двома чи 

більше елементами деталі, що мають бути паралельними одна одній. 

• Perpendicular Mate: дозволяє встановлювати сполучення між 

двома чи більше елементами деталі, що мають бути перпендикулярними 

одна одній. 

• Tangent Mate: дозволяє встановлювати сполучення між двома чи 

більше елементами деталі, що мають мати спільну дотичну точку. 

• Concentric Mate: дозволяє встановлювати сполучення між двома 

чи більше елементами деталі, що мають мати спільну вісь обертання. 

• Lock Mate: дозволяє встановлювати сполучення між двома чи 

більше елементами деталі, причому це призводить до повно обмеження 

всіх ступенів свободи між ними. 

• Distance Mate: дозволяє встановлювати сполучення між двома чи 

більше елементами деталі, що мають мати певну відстань одна від одної. 

• Angle Mate: дозволяє встановлювати сполучення між двома чи 

більше елементами деталі, що мають мати певний кут між собою. 

Інструмент Mate дозволяє встановлювати необмежену кількість 

сполучень між деталями для точного позиціонування деталі в складальній 

одиниці. На рисунку 4.15 показано поле Mate Selections після вибору 

циліндричних поверхонь (рисунок 4.16) для сполучення. 

 

 
 

Рисунок 4.15 – Поле Mate Selections з вибраними поверхнями  

для сполучення 

 

Після підтвердження вибору сполучення в FeatureManager Design 

Tree в Mates з’явиться відмітка Concentric2 (Верхня пластина <1>, 

Нижня пластина <1>) про використання сполучення (рисунок 4.17), яку. 

за потреби, можна буде редагувати. Накладене сполучення зменшує 

кількість ступенів вільності деталі «Нижня пластина». Однак деталь 

«Нижня пластина» може ще обертатися навколо осі отвору та рухатися 

вздовж осі отвору. Щоб досягти повного сполучення між деталями, 

потрібно накласти ще декілька сполучень, які унеможливлять перераховані 

вище рухи. 
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Рисунок 4.16 – Візуалізація сполучення циліндричних поверхонь із 

використанням Concentric Mate 

 

 
 

Рисунок 4.17 – Додавання відмітки про використання сполучення в Mates 

 

Таким чином. використовуючи сполучення між деталями та 

стандартними елементами, можна виконати різьбове з’єднання складальної 

одиниці (рисунок 4.18). 

 

 
 

Рисунок 4.18 – Різьбове з’єднання складальної одиниці 
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Щоб створити прямозубе циліндричне колесо, потрібно викликати 
контекстне меню на піктограмі «Spur Gear» та вибрати опцію «Create 
Програмний продукт SOLIDWORKS в своєму асортименті Toolbox має 
інструменти для автоматичного створення тривимірних моделей зубчастих 
коліс та рейок (ISO → Power Transmission → Gears). Тривимірні моделі 
зубчастих коліс та рейок містять: косозубе (Helical Gear) та прямозубе 
(Spur Gear) циліндричні колеса, внутрішнє прямозубе колесо (Internal 
Spur Gear), конічні зубчасті колеса (Straight Bevel Gear, Straight Bevel 
Pinion, Straight Miter Gear) та рейку (Rack). 

Для створення прямозубого циліндричного колеса потрібно визвати 
контекстне меню на піктограмі «Spur Gear» та вибрати опцію «Create 
Part…», як показано на рисунку 4.19. 

 

 
 

Рисунок 4.19 – Створення прямозубого циліндричного колеса 

 

З’явиться функція Configure аналогічна як для налаштування 

параметрів шайби Washers, однак містить налаштування параметрів лише 

для Spur Gear (рисунок 4.20). У процесі налаштування параметрів Spur 

Gear потрібно вказати: модуль зубчастого колеса (Module), кількість зубів 

(Number of Teeth), кут зачеплення (Pressure Angle), ширину зубчастого 

вінця (Face Width), тип маточини (Hub Style), діаметр маточини (Hub 

Diameter), повну ширину колеса (Overall Length), номінальний діаметр 

вала (Nominal Shaft Diameter), тип шпонкових пазів (Keyway), кількість 

показуваних зубів на тривимірній моделі зубчастого колеса (Show Teeth). 

В опції Configure також буде показано повне ім’я створеного файлу з 

деталлю та напис, який буде відображатися у специфікації. 
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Рисунок 4.20 – Налаштування параметрів Spur Gear 

 

Варто звернути увагу на те, що модулі зубчастих коліс відповідають 

стандартному ряду, кількість зубів не може бути меншою 10, кут 

зачеплення обмежений лише двома значеннями: 20о та 14,5о, подано три 

типи маточин: без неї, симетрично та консольно розміщені, передбачено 

три типи шпонкових пазів: без паза, один паз та два пази, максимальне 

значення номінального діаметра вала становить 500 мм. 

Після створення тривимірної моделі зубчастого колеса буде 

доступна можливість редагування його автоматично створених елементів. 

Це дозволить додати до тривимірної моделі зубчастого колеса потрібні 

поверхні, які не можна було автоматично створити функцією Configure. 

 
4.2 Завдання до виконання лабораторної роботи № 4 
 
Завдання до лабораторної роботи № 4 складається з двох частин для 

30 індивідуальних варіантів. Перша частина завдання містить 
проєктування складальної одиниці різьбових з’єднань згідно з отриманим 
варіантом завдання. Складальною одиницею першої частини завдання є 
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пластини з отворами для з’єднання. Будуючи складальну одиницю 
першого завдання потрібно використати шаблон Assembly. 

Друга частина завдання охоплює проєктування твердотільної 
тривимірної моделі прямозубого циліндричного колеса за отриманим 
варіантом завдання згідно з вихідними даними. Для побудови здобувачам 
потрібно використати Spur Gear в Power Transmission та ввести потрібні 
значення функції Configure. 

Якщо кількість здобувачів в групі більша, ніж підготовлених 
варіантів завдань, то потрібно звернутися до викладача за додатковими 
варіантами. 

Виконуючи завдання здобувачі проєктують повністю визначені 
ескізи з використанням розмірів та взаємозв’язків. 

 

4.2.1 Перша частина завдання до лабораторної роботи № 4 
 

Варіант 1 

 

Варіант 2 
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Варіант 3 

 

 

Варіант 4 

 

 

Варіант 5 
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Варіант 6 

 

 

Варіант 7 

 

Варіант 8 
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Варіант 9 

 

Варіант 10 

 

 

Варіант 11 
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Варіант 12 

 

 

 

Варіант 13 

 

 

 

Варіант 14 
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Варіант 15 

 

 

Варіант 16 

 

 

Варіант 17 
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Варіант 18 

 

Варіант 19 

 

Варіант 20 
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Варіант 21 

 

Варіант 22 

 

Варіант 23 
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Варіант 24 

 

 

Варіант 25 

 

 

Варіант 26 
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Варіант 27 

 

Варіант 28 

 

Варіант 29 
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Варіант 30 

 

 

4.2.2 Друга частина завдання до лабораторної роботи № 4 
Кут нахилу зачеплення (Pressure Angel) дорівнює 20 градусів для 

всіх варіантів. 
 

Таблиця 4.3 – Основні параметри зубчастого вінця 

В
а
р

іа
н

т
 

М
о
д

у
л
ь
 

(M
o
d

u
le

),
 

м
м

 

Кількість 

зубів 

(Number of 

Teeth) 

Ширина 

зубчастого 

вінця (Face 

Width), мм В
а
р

іа
н

т
 

М
о
д

у
л
ь
 

(M
o
d

u
le

),
 

м
м

 

Кількість 

зубів 

(Number of 

Teeth) 

Ширина 

зубчастого 

вінця (Face 

Width), мм 

1 1,25 50 10 16 6,5 34 52 

2 1,375 60 11 17 7 30 56 

3 1,5 70 12 18 8 28 64 

4 1,75 80 14 19 9 26 72 

5 2 55 16 20 10 25 80 

6 2,25 40 18 21 11 24 88 

7 2,5 30 20 22 12 22 96 

8 2,75 24 22 23 14 20 112 

9 3 30 24 24 16 19 128 

10 3,5 28 28 25 18 18 144 

11 4 14 32 26 20 15 160 

12 4,5 48 36 27 22 22 176 

13 5 42 40 28 25 23 200 

14 5,5 38 44 29 28 24 224 

15 6 36 48 30 32 17 256 
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Таблиця 4.4 – Основні параметри маточини 

В
а
р

іа
н

т
 

Тип 

маточини 

(Hub Style) 

Діаметр 

маточини (Hub 

Diameter), мм 

Загальна 

ширина 

колеса 

(Overall 

Length), мм 

Діаметр отвору 

для кріплення 

колеса 

(Nominal Shaft 

Diameter), мм 

Місце під шпонку 

(Keyway) 

1 Type A None None 20 None 

2 Type С 45 25 25 Rechangular(1) 

3 Type A None None 40 Rechangular(2) 

4 Type B 90 30 50 None 

5 Type A None None 45 Rechangular(1) 

6 Type С 63 30 35 Rechangular(2) 

7 Type A None None 30 None 

8 Type B 36 35 20 Rechangular(1) 

9 Type A None None 35 Rechangular(2) 

10 Type С 57 40 38 None 

11 Type A None None 15 Rechangular(1) 

12 Type B 144 50 80 Rechangular(2) 

13 Type A None None 74 Rechangular(1) 

14 Type С 135 60 75 Rechangular(2) 

15 Type A None None 80 Rechangular(1) 

16 Type B 153 70 85 Rechangular(2) 

17 Type A None None 74 Rechangular(1) 

18 Type С 153 80 85 Rechangular(2) 

19 Type A None None 90 Rechangular(1) 

20 Type B 171 100 95 Rechangular(2) 

21 Type A None None 100 Rechangular(1) 

22 Type С 180 130 100 Rechangular(2) 

23 Type A None None 110 Rechangular(1) 

24 Type B 216 150 120 Rechangular(2) 

25 Type A None None 120 Rechangular(1) 

26 Type С 198 190 110 Rechangular(2) 

27 Type A None None 150 Rechangular(1) 

28 Type B 306 260 170 Rechangular(2) 

29 Type A None None 200 Rechangular(1) 

30 Type С 288 300 160 Rechangular(2) 

 

4.3 Порядок виконання роботи 

 

1. Ознайомитись з теоретичними відомостями до лабораторної 

роботи. 

2. В звіті вказати тему та мету роботи. 

3. Ознайомитися з описом роботи та завданням. 

4. Відповідно до виданого варіанта для першої частини завдання 

виконати проєктування складальної одиниці різьбових з’єднань в програмі 
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SOLIDWORKS. Зокрема нанести усі потрібні сполучення, щоб повністю 

вибрати ступені вільності в елементів складальної одиниці.  

5. Відповідно до виданого варіанта для другої частини завдання 

виконати проєктування твердотільної тривимірної моделі прямозубого 

циліндричного колеса в програмі SOLIDWORKS. Виконуючи завдання 

вказати задані параметри, зазначити матеріали деталі AISI 1035, що 

еквівалентно марці Сталь 35 ДСТУ 7809:2015. 

6. Дати відповіді на контрольні питання. 

7. Завершити виконання звіту до лабораторної роботи формуванням 

висновків. У висновках вказати інструменти програми SOLIDWORKS, які 

вдалося опанувати у процесі виконання лабораторної роботи. Вказати 

скільки сполучень міститься в складальній одиниці для першої частини 

завдання та масу спроєктованого прямозубого циліндричного колеса. 

 

4.4 Контрольні питання 

 

1. Які основні стандарти для стандартних елементів 

використовуються в програмі SOLIDWORKS? 

2. Який модуль відповідає за бібліотеку елементів в програмі 

SOLIDWORKS та як його запустити? 

3. Яка функція забезпечує налаштування розмірів, вибір матеріалу 

та інших параметрів стандартних елементів та як її викликати? 

4. Який інструмент відповідає на накладання пар/сполучень 

елементів та вказати їх основні типи? 

5. Які параметри можна налаштувати у разі автоматичного 

проєктування прямозубого циліндричного колеса в програмі 

SOLIDWORKS? 
6. Які обмеження існують для проєктування прямозубих 

циліндричних коліс в програмі SOLIDWORKS? 
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ЛАБОРАТОРНА РОБОТА № 5 

 

СТВОРЕННЯ АСОЦІАТИВНИХ КРЕСЛЕНИКІВ ІЗ 

ТРИВИМІРНИХ МОДЕЛЕЙ ДЕТАЛЕЙ 

 

 

Мета роботи. Вивчення методики створення асоціативних 

креслеників із тривимірних моделей деталей, способів задання розмірів і 

визначення взаємозв’язків об’єктів кресленика в системі автоматизованого 

проєктування SOLIDWORKS. 

 

5.1 Короткі теоретичні відомості 

 

Формати креслеників – це паперові або електронні аркуші 

креслеників потрібного розміру. Налаштування властивостей формату 

кресленика викликається через команду Properties… в контекстному меню 

(рисунок 5.1). 

 

 
 

Рисунок 5.1 – Контекстне меню кресленика в FeatureManager Design Tree 

 

У процесі налаштування в діалоговому вікні Sheet Properties 

(рисунок 5.2) визначаються розміри масштабу зображення на кресленику, 

вибір самого формату аркуша з основним написом та попередньо 

налаштованими параметрами шаблону. 
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Рисунок 5.2 – Налаштування параметрів кресленика 

 

Позначення форматів креслеників складається з букв А і арабських 

цифр від 0 до 5 [8]. Габаритні розміри основних форматів креслеників 

наведено в таблиці 5.1. Додаткові формати креслеників можуть 

формуватися шляхом збільшення в 2, 3 і т. д. разів їх висоти. 
 

Таблиця 5.1 – Основні формати креслеників 
Позначення Габаритні розміри, мм Позначення Габаритні розміри, мм 

А0 841×1189 А3 297×420 

А1 594×841 А4 210×297 

А2 420×594 А5 148×210 

 

На форматах креслеників зазвичай розміщується основний напис [9]. 

Основний напис – це сукупність встановлених властивостей виробу і 

виконаного на нього конструкторського документа. Він розташовується у 

правому кутку над нижньою лінією рамки поля конструкторського 
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документа. Основні написи, додаткові графи до них і рамки виконують 

основними та суцільними тонкими лініями. 

Основний напис першого аркушу має містити графи, які позначені 

цифрами в дужках, та регламентовані розмірами рамок, відповідно, 

рисунку 5.3. У закладах освіти зазвичай заповнюються такі графи 

основного напису: граф 1 – назва виробу, зображеного на кресленику 

(спочатку пишуть іменник, потім визначення); графа 2 – позначення 

(шифр) кресленика; графа 3 – позначення матеріалу, виконується лише для 

деталі; графа 4 – літера, що присвоєна документу (літера «Н» – для 

навчальних креслеників); графа 5 – маса виробу в кілограмах; графа 6 – 

основний масштаб зображення на кресленику; графа 7 – найменування 

закладу освіти (організації) та групи; графа 8 – прізвища здобувача, 

викладача та інших відповідальних осіб; графа 9 – підписи здобувача, 

викладача та інших відповідальних осіб; графа 10 – дата накладання 

підпису; графа 11 – порядковий номер аркуша; графа 12 – загальна 

кількість аркушів конструкторського документа; графа 13 – відомості про 

зміну конструкторського документа. 
 

 
 

Рисунок 5.3 – Оформлення та графи основного напису першого аркуша 

конструкторської документації 

 

Оформлення основних написів інших аркушів конструкторської 

документації можна розглянути за літературою [9]. 

Масштаб (Scale) – це числове відношення розмірних параметрів 

об’єкта на кресленику, карті та інших зображеннях до реальних розмірів 

об’єкта [8, 10]. Масштаби, зазвичай, обирають залежно від габаритів 

зображуваного виробу, щоб максимально заповнити ділянку побудови 

кресленика. Існує три групи фіксованих масштабів: масштаби зменшення 

(1:2; 1:2,5; 1:4; 1:5; 1:10; 1:15; 1:20; 1:25; 1:40; 1:50; 1:5; 1:100;1:200; 1:400; 

1:500; 1:800; 1:1000); натуральна величина (1:1); масштаби збільшення 

(2:1; 2,5:1; 4:1; 5:1; 10:1; 20:1; 40:1; 50:1; 100:1). 
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Створення асоціативних креслеників передбачає виконання в САD 

системі креслеників тривимірних моделей деталей згідно з вимогами 

стандартів Єдиної системи конструкторської документації (ЄСКД) [11]. 

Зокрема після зміни формату, розмірів чи параметрів моделі одночасно 

змінюється її зображення на всіх пов’язаних з нею асоціативних виглядах. 

Процес створення асоціативних креслеників передбачає 

налаштування у вікні Properties у вкладці Custom (рисунок 5.4) для 

тривимірної моделі. Шлях до відкриття вікна Properties починається з 

меню файлу тривимірної моделі: File → Properties. 

 

 
 

Рисунок 5.4 – Налаштування Properties тривимірної моделі деталі 

 

На цьому етапі потрібно вказати Property Name – назву позиції, яку 

описує властивість тривимірної моделі, Type – тип даних властивості, 

Value/Text Expression –потрібне значення властивості, а також результат 

виконання властивості буде відображено в колонці Evaluated Value. 

Колонку Value/Text Expression зазвичай заповнюють вручну, або за 

допомогою наявних властивостей моделі, наприклад, властивість маси 

моделі “SW-Mass@Гайка.SLDPRT” вибирається зі спадного списку. 

Наступним етапом налаштування асоціативного кресленика є 

оформлення всіх елементів основного напису (рисунок 5.5). В такому разі 

потрібно в контекстному меню (див. рисунок 5.1) обрати пункт Edit Sheet 

Format. Відкриється доступ до редагування основного напису, в якому 

вказати однойменні налаштування тривимірної моделі (рисунок 5.4), 

використовуючи такий формат: $PRPSHEET: ”Властивість” та додаючи 

Link to Property з вкладки PropertyManager розділу Text Format. 
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Рисунок 5.5 – Налаштування основного напису асоціативного кресленика 
 

Налаштування основного напису асоціативного кресленика можна 

зберегти в шаблонах за допомогою шляху File → Save Sheet Format… і 

використовувати для майбутніх побудов. 

На рисунку 5.6 показано результат використання збереженого 

шаблону асоціативного кресленика, який автоматично заповнює основний 

напис із властивостей тривимірної моделі. Зокрема обов’язково 

виконується редагування розмірів і розміщення заповнених граф. 

 

 
 

Рисунок 5.6 – Основний напис після використання шаблону та редагування 
 

Заповнення граф основного напису можна також виконувати шляхом 
вписування кожного пункту вручну для кожної моделі. Однак, змінюючи 
вписані параметри, потрібно використовувати ручне редагування кожної 
зміни, що є затратним за часом. 

В машинобудуванні у процесі креслення використовують різні типи 
ліній (рисунок 5.7), які відрізняються товщиною і виконанням та 
налаштовуються у вкладці Line Style у вікні Document Properties. 
Основними типами ліній є Solid (основна та суцільна тонка лінії, які 
відрізняються товщиною. Основні лінії відповідають за лінії видимого 
контуру, а суцільні тонкі лінії – за розмірні та виносні лінії), Dashed 
(штрихова для зображення невидимих контурів виробу), Center (штрих-
пунктирна тонка для зображення осьових і центральних ліній) та Phantom 
(штрихпунктирна з двома точками тонка для зображення виробів в 
проміжних положеннях, ліній згину на розгортках). 
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Рисунок 5.7 – Стилі ліній в SOLIDWORKS 

 

Налаштування стилю та товщини ліній для конкретних 

геометричних елементів кресленика показано на рисунку 5.8 у вкладці 

Line Front у вікні Document Properties. Наприклад, для Visible Edges 

(видимих ребер) застосовують Style → Solid, Thickness → 0.5 mm; для 

Hidden Edges (невидимих ребер) – Style → Dashed, Thickness → 0.18 mm; 

для Construction Curves (криві побудови) – Style → Center, Thickness → 

0.18 mm; для Area hatch/fill (область штрихування/заповнення) – Style → 

Solid, Thickness → 0.18 mm. 

Зображення виробів мають виконуватися за методом прямокутного 

проєктування. За основні площини проєкцій приймають шість граней куба, 

на які може бути спроєктований будь-який виріб (рисунок 5.9) [8]. 
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Рисунок 5.8 – Налаштування ліній елементів кресленика 

 

 
 

Рисунок 5.9 – Розташування основних виглядів 
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Для досягнення розміщення основних виглядів, як на рисунку 5.9, в 

налаштуваннях параметрів кресленика Sheet Properties (див. рисунок 5.2) 

потрібно в полі Type of projection вибрати позицію First angle. Крім цього 

варто враховувати, що число зображень на кресленику має бути 

найменшим, але забезпечувати повне уявлення про виріб. 

Зображення на кресленику створюються за допомогою вкладки 

Drawing панелі інструментів SOLIDWORKS (рисунок 5.10). Так, для 

створення стандартних трьох виглядів виробу на кресленику потрібно 

використати інструмент Standard 3 View, вибрати попередньо створену 

тривимірну модель, і SOLIDWORKS автоматично сформує основні 

вигляди на робочому полі кресленика. Результат використання 

інструмента Standard 3 View показано на рисунку 5.11. 

 

 
 

Рисунок 5.10 – Вкладка Drawing панелі інструментів 

 

 
 

Рисунок 5.11 – Автоматична побудова трьох стандартних виглядів 

інструментом Standard 3 View 
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Схожий за властивостями інструмент Model View, але лише для 

одного вибраного вигляду виробу. При цьому сформований вигляд деталі 

можна розмістити в потрібному місці робочого поля SOLIDWORKS. 

Після створення основного вигляду в робочому полі SOLIDWORKS 

можна створити різні проєкційні вигляди від нього за допомогою 

інструмента Projected View. А налаштування проєкційного зв’язку нового 

вигляду виконується за рахунок його контекстного меню та позицій 

Alignment → Break Alignment, Default Alignment та інші. 

Інструмент Auxiliary View відповідає за створення вигляду виробу 

згідно з вибраним потрібним його ребром. В цьому випадку створюється 

позначення стрілочки з літерою, яка вказує напрям спостереження вигляду 

та робить відповідну проєкцію. Створений вигляд має зверху назву літери, 

яка була вказана на стрілочці, а також може містити в дужках масштаб, 

якщо він відрізняється від того, який вказано в основному написі. 

За створення розрізів виробу відповідає інструмент Section View, а 

за створення перерізів – інструмент Removed Section. Розріз відрізняється 

від перерізу тим, що на вигляді розрізу показують січну площину та те, що 

розташовано за нею, а для перерізу – лише січну площину. Розрізи 

позначаються потовщеними лініями зі стрілочками та літерами. На 

створеному розрізі вказуються дві великі літери через дефіс, а також в 

дужках масштаб, якщо він відрізняється від того, що вказано в основному 

написі. Приклад виконаного розрізу А-А показано на рисунку 5.12 [2]. 

 

 
Рисунок 5.12 – Виконання розрізу А-А 
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Інструмент Detail View відповідає за виносні елементи. Це додаткове 

окреме зображення (зазвичай збільшене) частини виробу, яке вимагає 

графічного пояснення щодо форми, розмірів й інших даних (рисунок 5.13). 

Виносний елемент потрібно розташовувати ближче до відповідного місця 

на зображенні виробу. Це місце позначають замкнутої суцільною тонкою 

лінією (коло, овал тощо) з позначенням літери на полиці лінії-виноски. 

Виносний елемент забезпечується написом: літерою, яка була присвоєна у 

процесі побудови місця позначення та в дужках масштабом, якщо 

виконаний виносний елемент має відмінне значення від масштабу 

основного напису. 

 

 
 

Рисунок 5.13 – Виконання виносного елемента Б 

 

За створення винесеного вигляду відповідає інструмент Broken-out 

Section. Цей інструмент аналогічний створенню місцевого вигляду, тільки 

задається контур вигляду і глибина (або гранична лінійна кромка) вирізу 

(рисунок 5.14) [2]. Після створення винесеного вигляду виділена площа 

виробу заштриховується, де присутній матеріал. Винесений вигляд 
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дозволяє показати внутрішні елементи виробу, не вдаючись до створення 

додаткових виносних елементів чи розрізів. 

 

 
 

Рисунок 5.14 – Виконання інструмента Broken-out Section 
 

В процесі креслення занадто довгих виробів використовують 

інструмент Break View, який забезпечує видалення виділеної частини 

виробу (рисунок 5.15) [2]. Після активації інструмента виділяють частину 

виробу двома хвилястими тонкими лініями під позиціями 1 та 2. Ділянка 

між хвилястими тонкими лініями буде видалена, а між ними сформується 

зазор, який можна налаштувати через параметр Gap size. Кількість таких 

виділених частин виробу визначається конструктором для наочного 

відображення всіх потрібних геометричних елементів виробу. 
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Рисунок 5.15 – Використання інструмента Break View 

 

Вкладка Annotation (рисунок 5.16) панелі інструментів 

SOLIDWORKS відповідає за налаштування та позначення розмірів, 

позицій, шорсткості, зварних швів, осей та елементів вимог до точності. 

 

 
 

Рисунок 5.16 – Вкладка Annotation панелі інструментів 

 

Інструмент Smart Dimension відповідає за нанесення розмірів на 

кресленику при послідовному їх нанесенні [2], а для автоматичного 

нанесення всіх можливих розмірів використовують інструмент Model 

Items. Однак інструмент Model Items добре працює для нескладних 

виробів з малою кількістю розмірів. В іншому випадку складно 

відредагувати розташування розмірів, які створені автоматичним шляхом. 

Для правильного розташування розмірів на кресленику варто 

ознайомитися з правилами їх нанесення [12]. 

Додавання написів на кресленику відбувається за допомогою 

інструмента Note. Властивості інструмента Note дозволяють змінювати 

формати тексту, додавати символи, стрілочки для вказання на елементи 

виробу.  



 

100 

Інструмент Balloon відповідає за додання виносок до компонентів 

виробу. Досить активно застосовують інструмент Auto Balloon для 

автоматичного формування виносок до компонентів виробу. Ці 

інструменти забезпечують ефективне виконання складальних креслеників. 

Додавання та налаштування позначень шорсткості поверхні 

забезпечується інструментом Surface Finish (рисунок 5.17). У процесі 

з’являються можливості редагувати стиль напису, вибрати позначення 

шорсткості, вказати потрібні параметри та забезпечити позиціонування під 

потрібним кутом чи зі стрілочкою. 

 

 
 

Рисунок 5.17 – Налаштування властивостей інструмента Surface Finish 

 

Налаштування виносок для позначення зварних з’єднань 

відбувається через інструмент Weld Symbol (рисунок 5.18). Тоді ж 

з’являється можливість налаштувати тип стрілочки, використати потрібні 

позначення швів зварювання, редагувати текст й інші. 
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За позначення допусків форми та розташування поверхонь 

відповідає інструмент Geometric Tolerance (рисунок 5.19). Інструмент 

Geometric Tolerance має інтуїтивні налаштування для вибору потрібного 

позначення допуску, налаштування його параметрів, виносок, належність 

до відповідної бази. Основні норми для налаштування допусків форми та 

розміщення поверхонь подано в стандарті [13]. 
 

 
 

Рисунок 5.18 – Діалогове вікно налаштування позначень зварних швів 
 

 
 

Рисунок 5.19 – Налаштування інструмента Geometric Tolerance 
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Позначення баз на кресленику відбувається інструментом Datum 

Feature. Основні налаштування інструмента Datum Feature наведено на 

рисунку 5.20. 

 

 
 

Рисунок 5.20 – Налаштування інструмента Datum Feature 

 

В SOLIDWORKS за замовчуванням для циліндричних поверхонь та 

симетричних виробів передбачено автоматичне нанесення осьових ліній. 

Для нанесення осьових ліній вручну використовують інструменти Center 

Mark та Certerline. Інструмент Center Mark відповідає за нанесення 

осьових ліній для кіл, овалів, пазів та інше (рисунок 5.21), а інструмент 

Certerline забезпечує ручне нанесення центральної лінії між двома 

ребрами або елементами ескізу. 

 

 
 

Рисунок 5.21 – Налаштування інструмента Center Mark 
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Ручне нанесення штриховки або заливки передбачено інструментом 

Area Hatch/Fill (рисунок 5.22).  У властивостях Properties передбачено 

вибір вигляду штриховки, її щільність і кут нахилу, а також розташування. 

 

 
 

Рисунок 5.22 – Налаштування інструмента Area Hatch/Fill 

 

5.2 Командні завдання до виконання лабораторної роботи № 5 

 

Завдання до лабораторної роботи № 5 заплановано до виконання в 

команді здобувачів. Команда здобувачів складається максимум з 2-х осіб, 

оскільки, за умовою завдань, потрібно підготувати тривимірну модель 

виробу (передбачено виконання одним здобувачем) і провести оформлення 

робочого кресленика цього ж виробу (передбачено виконання іншим 

членом команди) з відповідними нанесеними розмірами, допусками, 

шорсткістю та технічними вимогами. 

Команда формується після ознайомлення з теоретичним матеріалом 

до лабораторної роботи перед її виконанням. Про сформування команди 

здобувачів потрібно повідомити викладача щоб отримати варіант завдання. 

У процесі виконання завдання здобувачі в команді можуть 

допомагати один одному та перевіряти правильність застосування 

відповідних інструментів для проєктування тривимірної моделі з робочим 

креслеником. 

Після виконання завдань в основному написі вказується номер 

команди для звітності. 

ОБОВ’ЯЗКОВО!!! В основному написі має бути вказана маса 

виробу, крім інших відповідних позначень. 
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5.3 Порядок виконання роботи 

 

1. Ознайомитись з теоретичними відомостями до лабораторної 

роботи. 

2. Сформувати команди для вирішення завдання. 

3. В звіті вказати тему та мету роботи. 

4. Ознайомитися з описом роботи та завданням. Розподілити 

обов’язки в команді для ефективного виконання завдання. 

5. Виконати тривимірну модель виробу за варіантом завдання. 

Також обов’язково вказати потрібні атрибути у вікні Properties у вкладці 

Custom. Вибрати матеріал виробу згідно з завданням (дозволяється 

вибрати аналог матеріалу згідно зі стандартами ISO або DIN). 

6. Виконати робочий кресленик згідно з завданням із тривимірної 

моделі. Зокрема мають бути нанесені всі потрібні розміри, допуски форми 

та розташування поверхонь, шорсткість і технічні вимоги. В основному 

написі мають бути вказані основні атрибути тривимірної моделі, маса 

виробу та номер команди. 

7. Дати відповіді на контрольні питання. 

8. Завершити виконання звіту для лабораторної роботи 

формуванням висновків. У висновках вказати інструменти програми 

SOLIDWORKS, які вдалося опанувати, та отримані у процесі виконання 

лабораторної роботи навички. 

 

5.4 Контрольні питання 

 

1. Які існують формати креслеників? 

2. Які габарити основного напису першого аркуша кресленика 

згідно з ДСТУ ГОСТ 2.104:2006? 

3. Скільки існує груп фіксованих масштабів? 

4. Які типи ліній використовують у процесі оформлення 

креслеників? 

5. В чому суть методу прямокутного проєктування? 

6. Які інструменти входять до вкладки Drawing на панелі 

інструментів програми SOLIDWORKS? 

7. Які інструменти входять до вкладки Annotation на панелі 

інструментів програми SOLIDWORKS? 
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ЛАБОРАТОРНА РОБОТА № 6 

 

ЛИСТОВЕ ТРИВИМІРНЕ МОДЕЛЮВАННЯ ДЕТАЛЕЙ ТА ЇХ 

КРЕСЛЕНИКИ 

 

 

Мета роботи. Вивчення методів побудови листових тривимірних 

моделей та виконання їхніх креслеників із зображенням розгортки в 

системі автоматизованого проєктування SOLIDWORKS. 

 

6.1 Короткі теоретичні відомості 

 
Виготовлення деталей з листового металу є одним із найбільш 

використовуваних методів в машинобудуванні, тому що вироби з 
листового металу займають левову частку виробництва [14]. Згинання 
листового металу – це фундаментальний процес зміни форми металевого 
листа шляхом вигину в напрямку лінійної осі, також відомий як 
пресування чи штампування. Ця універсальна технологія дозволяє 
отримати різні типи профілів: V-подібний, U-подібний та більш складні 
конфігурації, що дає можливість виготовляти компоненти для таких 
галузей промисловості: автомобільна, аерокосмічна чи будівельна. 
Потрібно зрозуміти фізику процесу згинання листового металу, щоб 
правильно проєктувати вироби [15]. 

Згинання у формі та листозгинальний прес – це два основних 
методи, які переважають в операціях згинання листового металу. Кожен 
метод має унікальні переваги й підходить для конкретних виробничих 
сценаріїв. 

Згинання у формі застосовується для деталей зі складною геометрією 
та структурою, підходить для серійного виробництва. У цих процесах 
використовуються штампи, розроблені за індивідуальним замовленням, що 
дозволяє отримувати точні, повторювані форми їх поверхні, забезпечуючи 
стабільну якість деталей. 

Згинання на листозгинальному пресі застосовуються як для великих 
конструкцій, так і для малогабаритних деталей з листового металу. Висока 
швидкість переналаштування операції, що дозволяє за короткий час 
переходити від одного профілю вигину до іншого. Має значну 
економічність у разі малих і середніх обсягів виробництва. Досягається 
високий контроль за кутами та радіусами вигину завдяки регульованому 
оснащенню. 

Протягом операції згинання листового металу відбувається 
деформація заготовки таким чином, щоб вона прийняла потрібну форму. 
Так, одна частина листа металу змінює своє положення щодо іншої на 
певний кут по лінії контакту з пуансоном. Щоб деформація відбулася 
правильно, потрібно зробити певні розрахунки та врахувати фізико-
механічні властивості матеріалу. 
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Найбільш поширені листові деталі зі сталі: м’яка сталь 

(низьковуглецева сталь має в складі від 0,05% до 0,25% вуглецю, 

забезпечує гарну гнучкість та зварюваність, однак потребує додаткового 

покриття, бо легко піддається корозії); нержавіюча сталь – це сталь, що 

легована хромом більше як 10%, характеризується гарною пластичністю та 

корозійною стійкістю; високоміцна низьколегована сталь (HSLA) – сталь, 

що характеризується підвищеною міцністю та сформованістю порівняно з 

низьковуглецевою сталлю, що досягається за рахунок легуючих елементів 

ніобію або ванадію. Велику популярність мають листові деталі на основі 

алюмінієвих сплавів, оскільки досягається оптимальний баланс між малою 

вагою, корозійною стійкістю та пластичністю. Широко розповсюджені 

також листові деталі з міді та її сплавів, які мають високу 

електропровідність, терморегулювальні властивості та гарну пластичність. 

Операції зі згинання листового матеріалу мають відповідати певним 

міжнародним стандартам для забезпечення якості та безпеки. Для згинання 

листового матеріалу потрібно розглянути такі стандарти ISO (та українські 

аналоги ДСТУ): [16] стандарт встановлює вимоги до методів термічного 

різання, що охоплює лазерне та плазмове різання листового металу, які 

часто використовують перед операціями згинання; [17] стандарт визначає 

методи механічних випробувань, які використовуються для перевірки 

структури цілісності та механічних властивостей листових металів; [18] 

стандарт описує метод випробування металевих матеріалів на згин для 

оцінки пластичності листових деталей; [19] стандарт встановлює метод 

випробування металевих матеріалів на розтяг при контактній температурі 

та дає інформацію, яка впливає на процес згинання. 

Технологія згинання листового металу вимагає наявності 

спеціального устаткування. До того ж, після використання такого 

устаткування спостерігається мінімальна ймовірність виникнення тріщин й 

інших механічних дефектів. Лабораторна робота буде зорієнтована в 

напрямку операцій на листозгинальному верстаті. Існують дві категорії 

листозгинальних верстатів: звичайні та з числовим програмним 

керуванням. 

Основними інструментами для згинання є згинальний пуансон в 

верхній формі та V-подібна матриця в нижній формі (рисунок 6.1). 

Розрізняють різні типи пуансонів та матриць (рисунок 6.2) залежно від 

форми деталі. Крім цього, спеціалізоване виробництва може виготовляти 

на замовлення унікальні типи форми для вирішення складних задач із 

згинання металу. V-подібна матриця в нижній формі характеризується 

шириною розкриття жолоба матиці V та визначається за формулою (6.1): 
 

V≈6×s [мм],     (6.1) 

 

де s – товщина матеріалу. 
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Рисунок 6.1 – Основні інструменти для згинання 

 

 
а     б 

 

Рисунок 6.2 – Типи пуансонів (а) та матриць (б) 

 

Основний принцип роботи листозгинального верстата полягає в 

тому, що на матрицю встановлюють листовий метал та тиснуть зверху 

пуансоном для формування необхідного кута згину. При цьому потрібно 

враховувати такі параметрами (рисунок 6.3): s – товщина листового 

метала, V – ширина розкриття жолоба матриці, В – мінімальна ширина 

зігнутої сторони, R – мінімальний внутрішній радіус, F – діюче зусилля на 

1 метр. 

На листозгинальних верстатах зазвичай вказані таблиці для 

визначення необхідного зусилля для згинання 1 метра сталі з границею 

плинності 420 Н/мм2 під кутом 90о (приклад показано в таблиці 6.1). Однак 

(залежно від зміни параметрів операції згинання) вводять відповідні 

корективи [14]. 

Корекція зусилля згинання F (кН/м) залежно від виду матеріалу: 

 при згинанні нержавіючої сталі з границею плинності 700 Н/мм2 

потрібно F×1,7; 

 при згинанні алюмінієвих сплавів із границею плинності 

200 Н/мм2 потрібно F×0,5. 
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Рисунок 6.3 – Основні параметри, які потрібні для розрахунків листового 

згинання 
 

Таблиця 6.1 – Зусилля листозгинального верстата для заготовки 

довжиною 1 метр із границею плинності 420 Н/мм2 під кутом 90о 
[σ] = 420 Н/мм2 

s, 

мм 

4 5 6 8 10 12 16 20 25 32 40 50 63 80 V, мм 

3,0 3,5 4,0 5,5 6,5 8,0 10,5 13,0 16,5 21,0 26,0 32,5 41,0 52,0 B, мм 

0,5 0,7 0,8 1,0 1,3 1,5 2,0 2,5 3,2 4,4 5,0 6,5 8,0 10,0 R, мм 

0,6 60 50 30 20           

F, 

кН/м 

0,8 120 90 70 50 40          

1  150 110 80 60 50         

1,2   180 120 90 70 50        

1,5    210 150 120 80 60       

2     300 230 160 120 90      

2,5      390 270 200 140 110     

3       430 310 230 160 120    

4        600 440 320 230 180   

5         760 540 390 290 220  

6          850 620 450 330 250 

8           1210 880 700 460 

10            1510 1090 790 

12             1730 1240 

15              2130 

 

Корекція мінімальної ширини зігнутої сторони B (мм) залежно від 

кута згинання: 

при 30о – В×1,6; 

при 60о – В×1,1; 

при 90о – В×1,0; 

при 120о – В×0,9; 

при 150о – В×0,7. 
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Корекція мінімального внутрішнього радіуса R (мм) залежно від 

матеріалу: 

при згинанні алюмінієвих сплавів R×0,7; 

при згинанні низьковуглецевої сталі R×1,0; 

при згинанні нержавіючої сталі R×1,4; 

Однак у процесі операції згинання, навіть якщо врахувати попередні 

рекомендації, може спостерігатися ефект пружного відскоку [20] 

(рисунок 6.4). Величина кута пружного відскоку розраховується за 

формулою (6.2): 
 

Δα = b - a [град],    (6.2) 
 

де b – фактичний кут нахилу поверхонь деталі після пружного відскоку, 

а – кут нахилу поверхонь деталі в притиснутому стані. 
 

 
 

Рисунок 6.4 – Діаграма згинання і пружного відскоку 
 

Кут пружного відскоку при згинанні на 90о листової заготовки 

потрібно враховувати за рекомендаціями в таблиці 6.2. 
 

Таблиця 6.2 – Кут пружного відскоку при згинанні деталі на 90о 

Матеріал 
Співвідношення 

R/s 

Товщина s, мм 

<0,8 0,8-2 >2 

Низьковуглецева сталь <1 4o 2o 0o 

Латунь [σ]=350 МПа 1–5 5o 3o 1o 

Алюмінієві сплави, цинк >5 6o 4o 2o 

Середньовуглецева сталь 

[σ]=400-500 МПа 
<1 5o 2o 0o 

Мідь [σ]=350-400 МПа 1-5 6o 3o 1o 

Бронза [σ]=350-400 МПа >5 8o 5o 3o 

Високовуглецева сталь [σ] 

>500 МПа 

<1 7o 4o 2o 

1-5 9o 5o 3o 

>5 12o 7o 6o 
 

Отже, розраховуючи операцію згинання, потрібно врахувати велику 

кількість факторів. Підприємства, які мають досвідчених фахівців із 

згинання, створюють спеціальні таблиці відповідності, де враховано 
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попередньо згадані корекції та пружні відскоки листового металу. У 

процесі згинання потрібно дотримуватися основних принципів процесу 

згинання у відповідній послідовності: 

1 виконуємо згинання зсередини назовні; 

2 процес згинання починається від малих до великих елементів 

заготовки; 

3 спочатку згинаємо спеціальну форму, а потім загальну; 

4 після завершення попереднього процесу згинання потрібно 

врахувати, щоб він не впливав на наступні процеси чи заважав їм. 

Розглянемо поетапно процес згинання листової деталі (рисунок 6.5) 

на листозгинальному верстаті з застосуванням попередньо 

сформульованих правил. Перша операція (рисунок 6.6) – це згинання 

малих сторін розгортки доверху по лініях згину 1 та 2, які є колінеарними. 

 

 
 

Рисунок 6.5 – Розгортка листової деталі 
 

 
 

Рисунок 6.6 – Перша операція згинання 
 

Друга операція (рисунок 6.7) – це згинання довгої сторони розгортки 

донизу по лінії згину 3. 
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Рисунок 6.7 – Друга операція згинання 

 

Третя (рисунок 6.8) та четверта (рисунок 6.9) операції згинання є 

дзеркальним за своєю суттю відносно попередніх операцій та відповідають 

за аналогічне згинання елементів заготовки з іншої сторони. 

 

 
 

Рисунок 6.8 – Третя операція згинання 

 

 
 

Рисунок 6.9 – Четверта операція згинання 

 

Наступна, п’ята операція згинання (рисунок 6.10) забезпечує 

згинання малої сторони заготовки донизу по лінії згину 7. 
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Рисунок 6.10 – П’ята операція згинання 

 

Шоста операція згинання (рисунок 6.11) забезпечує згинання 

правого краю заготовки доверху по лінії згину 8. 

 

 
 

Рисунок 6.11 – Шоста операція згинання 

 

Наступна, сьома операція згинання (рисунок 6.12), відповідає за 

аналогічне згинання малої сторони заготовки з протилежного боку донизу 

по лінії згину 9.  

Завершальний етап виготовлення заготовки здійснюємо шляхом 

виконання восьмої операції згину (рисунок 6.13). У процесі цієї операції 

відбувається згинання лівої сторони заготовки доверху по лінії згину 10. 

Варто зауважити, що всі операції згинання (рисунки 6.6–6.13) 

відбувалися на кут 90о, а поняття «доверху» та «донизу» означають 

напрямок згинання сторони відносно передньої поверхні деталі на 

рисунку 6.5. 
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Рисунок 6.12 – Сьома операція згинання 

 

 
 

Рисунок 6.13 – Восьма операція згинання 

 

Реальний процес згинання може суттєво відрізнятися від процесу 

проєктування деталей з листового металу. Несуттєва різниця між цими 

процесами для інженера-конструктора виникає тоді, коли він виконує 

згинання елементів тривимірної моделі деталі з готової розгортки. Але 

більшість проєктної роботи інженер-конструктор виконує шляхом 

виготовлення тривимірної моделі деталі у процесі створення та додавання 

різних елементів згину. 

Для проєктування листової деталі використовують вкладку Sheet 

Metal на CommandManager (рисунок 6.14). У разі переходу до цієї 

вкладки доступний лише один інструмент Base Flange/Tab , з якого 

починається процес моделювання. 

Проєктуючи деталі з листового металу потрібно враховувати, що, 

використовуючи згини та проєктуючи тривимірну модель деталі у вкладці 

Sheet Metal, рано чи пізно доведеться використовувати інструменти не з 
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вкладки Sheet Metal (наприклад, видавлювання елементів та оболонки). 

Цей процес потрібно ретельно контролювати, адже в тривимірних моделях 

таких деталей можуть виниками помилки, і подальше проєктування з 

можливістю згинання чи розгинання розгортки буде заблоковано. 

 

 
 

Рисунок 6.14 – Вкладка Sheet Metal на CommandManager 

 

Виконаємо схожу конструкцію деталі «Корпус» (рисунок 6.15) із 

застосуванням інструментів для листового тривимірного моделювання. 
 

 
 

Рисунок 6.15 – Конструкція деталі «Корпус» 
 

Ескіз основи тривимірної моделі показано на рисунку 6.16. В ескізі 

основи вказано розмір довжини прямокутника 137,4 мм в зв’язку з тим, що 

у разі додавання інших елементів деталі її габарит буде збільшуватися на 

величину товщини металу та величину мінімального внутрішнього 

радіуса. Після створення ескізу основи вибираємо його в FeatureManager 

Design Tree та натискаємо на інструмент Base Flange/Tab. 
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Рисунок 6.16 – Ескіз основи тривимірної моделі 

 

На рисунку 6.17 показано налаштування PropertyManager: Sheet 

Metal Parameters товщина напряму 1 (Direction 1 Thickness) і зворотний 

напрямок (Reverse Direction), допуск на вигин (Bend Allowance) із 

параметром K-Factor, автоматичний рельєф (Auto Relief) та фантомне 

зображення деталі з листового металу. 

Після створення основи листової деталі варто вибрати матеріал 

тривимірної моделі деталі. В такому випадку обираємо матеріал AISI 1010 

Steel, який еквівалентний низьковуглецевій сталі марки Сталь 10 ДСТУ 

ГОСТ 7809:2015. 
 

 
 

Рисунок 6.17 – Побудова та налаштування параметрів основи 
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Варто зауважити, що при товщині металу s=2 мм для деталі з 

низьковуглецевої сталі можна прийняти згідно з таблицею 6.1 мінімальний 

внутрішній радіус R=1,3 мм. Параметр К-Factor приймає значення 

К=t/s=0,5 за замовчуванням та виконуємо моделювання без корекції цього 

параметра.  

K-Factor – це співвідношення, яке показує розташування 

нейтральної лінії листа відносно внутрішньої сторони деталі до загальної 

товщини металевої частини s. У такому випадку нейтральна лінія листа не 

піддається деформаціям розтягу чи стиску, а щоб розрахувати довжину 

заготовки (рисунок 6.18, б) розраховується допуск на вигин ВА (довжина 

дуги нейтральної осі між точками дотику А та В) за формулою (6.3) [21]: 

 

ВА = π×(R+K×s)×α/180 [мм].    (6.3) 

 

 
а       б 

 

Рисунок 6.18 – Лист металу після згинання (а) та до згинання (б) 

 

Створення стінки корпуса (рисунок 6.19, в) за допомогою 

інструмента Edge Flange показано на рисунку 6.19, а. У цьому процесі 

застосовуються параметри: радіус згину R=1,3 мм (Bend Radius), кут згину 

α=90o (Flange Angle), стінка виконується згідно з Blind на довжину 42 мм 

із застосуванням довжини до повної віртуальної форми згину (Outer 

Virtual Sharp), а параметр Flange Position встановлюємо на Bend Outside, 

щоб збільшити основу ескізу по довжині прямокутника 137,4 мм (див. 

рисунок 6.16). 

Важливою особливістю процесу моделювання є можливість 

редагувати ескіз поверхні (рисунок 6.19, б) за допомогою кнопки Edit 

Flange Profile. Так виконано зміщення сторін стінки від крайніх позицій на 

3,3 мм, що дорівнює величині радіуса згину та товщини листа (R+s). 
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а       б 

 
в 
 

Рисунок 6.19 – Параметри інструмента Edge Flange (а),  

ескізу стінки (б) та результат моделювання (в) 
 

Аналогічним чином проведено моделювання згину на стінці корпуса 

всередину моделі. Редагування ескізу для згину на стінці корпуса 

продемонстровано на рисунку 6.20.   
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Рисунок 6.20 – Редагування ескізу згину на стінці корпусу 

 

У процесі листового тривимірного моделювання можна 

застосовувати інструменти з інших вкладок (наприклад, на рисунку 6.21 

Features → Mirror). Однак, потрібно прослідкувати, що після цього 

деталь мала можливість розгортатися інструментом Flatten . 

 

 
 

Рисунок 6.21 – Використання інструмента Mirror для відображення згину 
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Продовжуємо процес листового тривимірного моделювання за 

допомогою інструмента Edge Flange для інших згинів на зовні моделі 

(рисунок 6.22). Використано Material Inside для параметра Flange 

Position, щоб виконати згин елементів врівень країв деталі. 

 

 
а 

 
б 
 

Рисунок 6.22 – Побудова інших згинів деталі «Корпус» 
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Оскільки деталь «Корпус» є симетричною, то остаточну побудову 

всіх елементів іншої стінки виконуємо за допомогою інструмента Mirror 

(рисунок 6.23). 
 

 
 

Рисунок 6.23 – Завершення побудови деталі «Корпус» 
 

Контрольна перевірка розмірів проводиться інструментом Measure, 

а працездатність листової тривимірної моделі – інструментом Pattern, щоб 

створити розгортку тривимірної моделі деталі «Корпус» (рисунок 6.24). 

 

 
 

Рисунок 6.24 – Розгортка тривимірної моделі деталі «Корпус» 
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Виконуємо оформлення властивостей тривимірної моделі (Properties 

на рисунку 6.25), які відображаються в основному написі асоціативного 

кресленика (рисунок 6.26).  
 

 
 

Рисунок 6.25 – Properties тривимірної моделі деталі «Корпус» 

 

Обов’язковим елементом будь-якого кресленика листової 

тривимірної моделі є вигляд розгортки з точними розмірами та місцями 

для згину. В технічних умова кресленика має бути вказано «* Розміри для 

довідок» та позначено «*» на розмірах товщини листа металу 2 мм та 

радіуса згину 1,3 мм, як показано на рисунку 6.26. 
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6.2 Завдання до виконання лабораторної роботи № 6 

 

Завдання до лабораторної роботи № 6 складається для 30 

індивідуальних варіантів та містить проєктування листової тривимірної 

моделі з асоціативним креслеником згідно з отриманим варіантом 

завдання. 

Якщо кількість здобувачів в групі більша, ніж підготовлених 

варіантів завдань, то потрібно звернутися до викладача за додатковими 

варіантами. У процесі виконання завдання здобувачі проєктують повністю 

визначені ескізи з використанням розмірів та взаємозв’язків. 
 

 

 
 

Рисунок 6.27 – Завдання варіантів 1…10 до лабораторної роботи № 6 
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Таблиця 6.3 – Параметри для варіантів 1…10 в мм на рисунку 6.27 

В
а

р
іа

н
т
 

А B C D E F s R1 R2 

1 400 350 50 300 75 200 4 30 5 

2 350 350 30 290 50 180 3 40 2 

3 370 420 60 250 60 160 2 30 2 

4 400 400 40 320 40 140 1,5 20 2 

5 380 200 30 320 40 150 5 25 5 

6 350 400 35 280 65 165 6 30 5 

7 370 250 20 330 55 170 1,5 35 1,5 

8 400 500 40 320 50 160 3 25 2,5 

9 420 380 30 360 60 230 8 40 8 

10 500 400 50 400 40 250 10 50 8 

Марка матеріалу: Сталь 10 ДСТУ 7809:2015 або AISI 1010 
 

 
 

Рисунок 6.28 – Завдання варіантів 11…20 до лабораторної роботи № 6 
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Таблиця 6.4 – Параметри для варіантів 11…20 в мм на рисунку 6.28 

В
а

р
іа

н
т
 

А1 А2 B C D E F G H s R 

11 500 250 800 200 400 500 150 100 50 4 5 

12 550 300 750 250 300 600 80 150 60 3 2,5 

13 600 300 700 300 300 500 200 120 70 2 2 

14 500 200 650 200 250 400 120 110 50 1,5 1,5 

15 400 250 600 150 300 450 100 100 50 5 5 

16 550 450 550 180 250 350 70 70 30 6 5 

17 500 250 500 100 200 300 100 90 45 1,5 2 

18 400 150 450 150 150 280 80 120 60 3 2 

19 350 100 400 100 200 300 70 50 20 8 8 

20 300 80 350 80 150 220 100 70 35 10 8 

Марка матеріалу: Сталь 15 ДСТУ 7809:2015 або AISI 1015 
 

 
 

Рисунок 6.29 – Завдання варіантів 21…30 для лабораторної роботи № 6 
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Таблиця 6.5 – Параметри для варіантів 21…30 в мм на рисунку 6.29 

В
а

р
іа

н
т
 

А B C D E F G s R1 R2 

21 200 350 200 100 50 60 70 3 2,5 30 

22 280 280 120 100 60 50 50 4 2,5 10 

23 250 300 100 150 50 100 75 2 2 20 

24 300 500 220 200 80 80 100 8 5 50 

25 550 650 320 200 50 50 90 5 5 45 

26 450 600 300 150 120 70 80 4 5 40 

27 500 500 200 200 100 150 110 1,5 2 50 

28 350 550 260 200 60 100 80 3 2 25 

29 400 500 250 180 75 90 100 8 8 20 

30 300 400 120 220 80 100 90 10 8 30 

Марка матеріалу: Сталь 20 ДСТУ 7809:2015 або AISI 1020 

 

6.3 Порядок виконання роботи 

 

1. Ознайомитись з теоретичними відомостями до лабораторної 

роботи. 

2. В звіті вказати тему та мету роботи. 

3. Ознайомитися з описом роботи та завданням. 

4. Відповідно до виданого варіанта завдання виконати 

проєктування листової тривимірної моделі з асоціативним креслеником в 

програмі SOLIDWORKS. На кресленику має бути побудована розгортка та 

нанесені усі потрібні розміри. 

5. Змінити марку матеріалу на алюмінієвий сплав 1350 за ДСТУ 

ISO 209-1:2002 та розрахувати як зміниться радіус згину та маса деталі. 

6. Дати відповіді на контрольні питання. 

7. Завершити виконання звіту до лабораторної роботи формуванням 

висновків. У висновках вказати інструменти програми SOLIDWORKS, які 

вдалося опанувати у процесі виконання лабораторної роботи. Описати 

позитивні та негативні сторони застосування іншого матеріалу для 

спроєктованої деталі з листового металу. 

 

6.4 Контрольні питання 

 

1. Які матеріали найбільш популярні для листового згинання на 

виробництві та чому? 

2. Якими стандартами регламентується підготовка то сам процес 

згинання листових деталей? 
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3. Як впливає збільшення кута згину на величину мінімальної 

ширини зігнутої сторони деталі? 

4. Які основні принципи застосовують для процесу згинання на 

виробництві? 

5. Які інструменти програми SOLIDWORKS використовують для 

згинання деталей на вкладці Sheet Metal? 

6. Розкажіть про параметр K-Factor та як розраховується допуск на 

вигин BA? 

7. Який інструмент відповідає за перегляд розгортки у процесі 

листового тривимірного моделювання? 

8. Які розміри для довідок варто позначати, оформляючи кресленик 

листової деталі? 
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1-ша та наступні сторінки 

Лабораторна робота 1 

 

Тема: загальні принципи тривимірного проєктування виробів в 

SOLIDWORKS. 

Мета роботи: ознайомлення з загальними принципами побудови 

тривимірних моделей деталей в системі автоматизованого проєктування 

SOLIDWORKS. 

 

Хід виконання роботи 

На рисунку 1.1 зображено результат використання інструмента 

Extrude Boss/Bace у процесі створення диска. 

 

  
 

Рисунок 1.1 – Створення диска 

 

 

Відповіді на контрольні запитання 

1. Яке призначення програми SOLIDWORKS? 

Основне призначення програми SOLIDWORKS – забезпечення 

наскрізного процесу проєктування (CAD), інженерного аналізу (CAE) та 

підготовки виробництва (CAM) виробів будь-якої складності… 
 

Висновок. У ході виконання лабораторної роботи ми ознайомились з 

інтерфейсом, налаштуваннями в SOLIDWORKS та основними принципами 

тривимірного проєктування виробів. Навчилися створювати тривимірну 

модель диска...  
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